We welcome comments or questions about this workbook and all aspects of Dragon documentation (instructional videos, Tutorial, User Guide, Installation Guide, Tip of the Day, Help menu, Performance Assistant, "What Can I Say" windows, etc.)

Please use the Product Feedback or Feature Request form at www.nuance.com/naturallyspeaking/contact for all feedback.

This workbook reflects the information available at the time of publishing. The Knowledge Base at nuance.com contains the latest technical information for version 10 (and previous versions.) The Support area of the website also includes printable documentation (User Guides, cheatsheets...) and listings of microphones, recorders, and other hardware tested and approved by Nuance for use with Dragon.

The website offers many other resources, including tips, videos, Frequently Asked Questions, Customer Service information, and a feature comparison between editions of Dragon.

It also lists, for each region, Value-Added Resellers who provide training and customization services for Dragon, in person or remotely. These Nuance partners can address your environment, equipment, goals, and needs; this is particularly efficient for very busy people, people new to computers, children, and in case of issues with hearing, vision, mobility, and dyslexia.
This Workbook’s Goals

Dragon NaturallySpeaking lets you speak naturally to perform tasks such as creating or editing documents, using e-mail, entering prices and other numeric data, searching your computer, and quickly finding on the Web maps, news, videos, images, and more. By reducing keyboard and mouse usage, you can gain productivity AND avoid strain on your wrists, shoulders, neck, and eyes!

This workbook aims to efficiently present what an end-user should know as quickly as possible — it does not cover every aspect of Dragon (the resources in Dragon’s Help menu and on nuance.com offer many details). It covers how to:

- **“Type by voice”** naturally and efficiently, which includes:
  - Dictating *anything* (including prices, phone numbers, addresses, URLs, symbols, punctuation, part numbers, acronyms, Roman numerals, units of measure, etc.)
  - Personalizing the software’s Vocabulary with custom words and phrases, *spoken forms* (pronunciations) and *written forms*, to ensure that Dragon is able to transcribe exactly what you want, even if what you said could be written in different ways.
  - Formatting, editing, and revising text, as well as Correcting Dragon’s errors if needed.
  - Creating *custom commands* to insert boilerplate content (commands of the type “Text-and-Graphics”, available in editions Preferred, Professional, Legal and Medical).

- **“Command and control”** your computer by voice, which includes:
  - Saying commands to use the Internet and e-mail, search your computer, open programs, click menus and buttons, close or minimize windows, switch between windows, etc.
  - “Voice-pressing” keys or key combinations on your keyboard.

*About Lesson Order, Prerequisites, and Hands-Free Usage*

For best efficiency, we strongly recommend you go through this workbook in order; it contains progressive explanations and illustrations, as well as step-by-step instructions and practice exercises; in addition, notes and tips provide further details and alert you to potential pitfalls.

**TIP** When directed to “click” items (buttons, menus, checkboxes...), feel free to instead use your voice, or keyboard shortcuts (underlined letters, Tab, spacebar...). If hands-free usage is important to you, read the lesson ‘Controlling the Operating System and Applications’ first, and see the Help about Dragon’s *MouseGrid* and commands for moving, clicking, and dragging the mouse.

To perform the exercises in this workbook, you should have basic familiarity with:

- Using Microsoft® Windows® to start or exit applications, open or save files, maximize windows, close dialog boxes, copy or move items, browse to folders, cut and paste, etc.
- Simple word-processing concepts such as bullet points, font size and font style, bolding and italicizing, right-aligning and centering, etc.
# Table of Contents

This Workbook’s Goals .................................................................................................................. iii

About Lesson Order, Prerequisites, and Hands-Free Usage ......................................................... iii

Table of Contents ........................................................................................................................ iv

Creating a User Profile ................................................................................................................ 1

“Adapt to writing style” - and a caution for multilingual users .................................................... 4

The Speed vs. Accuracy slider and Natural Language Commands .............................................. 4

Learning More and Getting Help ................................................................................................ 5

The Dragon User’s Guide ............................................................................................................. 5

The Accuracy Center and Accuracy Assistant ............................................................................. 5

The Online Help and Performance Assistant ............................................................................ 6

The Sample Commands window: “What Can I Say” .................................................................. 6

Why Customizing the Vocabulary is Important .......................................................................... 8

Customizing the Vocabulary—Using the Vocabulary Editor ....................................................... 9

Adding Vocabulary Entries: Words, Phrases, Acronyms ............................................................. 9

The importance of Spoken Forms ............................................................................................... 10

Deleting “Words” and Modifying “Word” Properties .................................................................. 12

Importing Lists of Vocabulary Entries ........................................................................................ 14

Customizing the Vocabulary from Existing Documents ............................................................. 16

Customizing the Vocabulary from Your E-Mail ......................................................................... 19

Starting to Dictate: Controlling the Microphone ......................................................................... 21

The DragonBar and the Microphone Icon .................................................................................... 21

Voice Commands for the Microphone and Sleep State ............................................................... 21

The Importance of Hot Keys, including Microphone On/Off ..................................................... 22

Starting to Dictate: Your First Dictation ....................................................................................... 23

Dictating Text and Punctuation Marks ....................................................................................... 23

New Line and New Paragraph .................................................................................................... 23

The Results Box .......................................................................................................................... 24

Dictating Special Text: Numbers, Dates, Addresses, Units ....................................................... 26

Special Text in Normal Dictation ............................................................................................... 26

Numbers Mode -- Dictating Numbers Exclusively ..................................................................... 27

Spell Mode -- Dictating Letters, Digits, and Other Characters ................................................ 28

The Spell Command -- Dictating a sequence of characters ...................................................... 28

Correcting Transcription Errors in Your Dictated Text .............................................................. 30

Copyright © 2010 Nuance Communications, Inc. All rights reserved
Boosting Productivity with Custom Commands

Dictating and editing in Microsoft Excel

Dragon NaturallySpeaking and Microsoft Word

Performing Audio Checks and Acoustic Training

Copyright © 2010 Nuance Communications, Inc. All rights reserved v
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Training Words from the Vocabulary Editor</td>
<td>63</td>
</tr>
<tr>
<td>Training While Correcting</td>
<td>63</td>
</tr>
<tr>
<td>Checking Acoustic Settings</td>
<td>64</td>
</tr>
<tr>
<td>Performing Additional Training</td>
<td>65</td>
</tr>
<tr>
<td>Creating and Using Multiple Vocabularies</td>
<td>66</td>
</tr>
<tr>
<td>Acoustic and Language Model Optimization</td>
<td>68</td>
</tr>
<tr>
<td>Launching the Acoustic and/or Language Model Optimization</td>
<td>68</td>
</tr>
<tr>
<td>Scheduling the Optimizations—and Data Collection</td>
<td>69</td>
</tr>
<tr>
<td>If Your Windows Password Changes</td>
<td>69</td>
</tr>
<tr>
<td>Copying User Profiles</td>
<td>71</td>
</tr>
<tr>
<td>Practice Exercise: Creating a Memo by Voice</td>
<td>72</td>
</tr>
</tbody>
</table>
Creating a User Profile

Dragon NaturallySpeaking is speaker-dependent software. To recognize your speech accurately, it must have a “profile” of you, which it stores in a set of files called user files (often referred to as “a User”).

The first time you launch Dragon, the program automatically brings up its New User Wizard, which takes you through the process of creating a profile; this includes choosing the right options for your “accent” and microphone type. After a verification of audio hardware and volume, this wizard can present you with text to read aloud for a few minutes—this step, called general training, allows Dragon to adapt its acoustic model to the unique way you sound.

In this lesson, as you discover the New User Wizard, you learn important tips that help optimize the accuracy of your new user profile right from the start.

- For best results, creating a User profile should be done in your “normal” environment, with the same background noise and equipment as when you will usually do your dictations.
- If you want to test your microphone independently of Dragon, you can use the Sound Recorder, a Windows accessory accessible from the Start menu.

Step 1: Make sure your microphone is connected and positioned correctly.

If using a headset, adjust it so that it feels comfortable and stable. The microphone must face the corner of your mouth (not the front) about a thumb's width away (you can experiment with the perfect distance for your particular case.) It should not touch your skin or hair.

IMPORTANT: Noise-canceling microphones only listen on one side; check that the listening side (often marked by a dot or the word TALK) is parallel to your face, not tilted up or down.

If your model has a mute switch, make sure it is in the ON position!

On some computers, connecting the microphone automatically brings up a small window asking what action you wish from this “audio system event”. Before closing this window, verify that its Microphone option is highlighted, as opposed to Line In.

Step 2: Launch Dragon (you can double-click its desktop icon). If Dragon has never been used before on this computer, this automatically brings up the first screen of the New User Wizard (otherwise, choose Manage Users in the Dragon toolbar’s NaturallySpeaking menu, then click New.)

Step 3: Enter a name for your User profile: your first and last names, for instance.
Step 4: Version 10 has special acoustic models for a number of broad “accents” heard in the US (this is particularly important for natives of the UK or the Indian sub-continent). Open the drop-down list Accent to see their names; if unsure which one is best for you, just pick “General”.

Step 5: Select the right Dictation source. If you are not using the default (microphone plugged into the Mic-In jack), open the drop-down list and pick your device’s type: for instance, Bluetooth Microphone.

The Help provides details on using special dictation sources such as array microphones and portable devices.

Many digital recorders (such as Olympus, Panasonic, Philips and Sony models) come with special software to manage recordings, including transferring them from recorder to computer and converting their format if necessary. Make sure to check your recorder’s documentation and install its software if required.

**IMPORTANT:** If you already have a Dragon profile and want to use an additional source, use the Open User dialog’s Source button to add a source instead of creating a separate profile for the new device. (Click NaturallySpeaking > Open User > Source > New.)

This is often overlooked, but very important. Having multiple sources within one profile allows the same Vocabulary to be used — and refined — no matter whether you are using your USB microphone or digital recorder, for instance. (As you will learn, personalizing the Vocabulary early and often is one of the keys to efficient usage.)

**TIP** Users with a small vocal cavity (as is often the case for children under about 13, depending on their height) may obtain best results by choosing “Teens” from the “Vocabulary” drop-down list.

Once you have completed the first screen of the New User Wizard, click Next.
Step 6: Next, Dragon will check audio settings.

Click the “Start Volume Check” button and read aloud the text in the gray box, exactly as presented, in a clear but natural voice. Feel free to say the punctuation if you wish.

Dragon will let you know when it has heard enough. Click Next. The next screen is similar: click “Start Quality Check”, read aloud, then click Next. Dragon will verify that your sound system is acceptable for speech recognition.

(The Knowledgebase at www.nuance.com contains details, including Technotes 6111 and 4720.)

Step 7: If you did not choose to skip “Initial Training”, Dragon then presents the first prompt to read: click Go, then read the short sentence displayed. When the “Select Text” box appears, choose one of the texts to read (the one entitled “Talking to your Computer” is recommended) and click OK.

Step 8: Proceed through the training text by reading it exactly as it is displayed. The words will turn gray once Dragon has “heard” them, but no need to wait for this to happen—just speak at your normal pace, clearly and naturally.

TIP Here Dragon is learning how you sound when you dictate; using the same tone, pace and volume you are likely to use day-to-day will help it recognize your future dictations most accurately. Saying punctuation isn’t necessary during acoustic training, but it’s a good idea to say at least the periods, to get into the habit. (Later, you will learn to dictate all punctuation and symbols.)

IMPORTANT: Take your time. Try to read naturally but precisely what is on the screen.

If the software needs to hear you re-read something, a yellow arrow will show you where to resume. If you mis-read something, just keep silent for a moment, then resume at the yellow arrow.

The Redo button lets you move the arrow back one “utterance”—useful if you realize you just misread something.

If you need to take a break, cough or sneeze, click the Pause button. That button will then be labeled Go; click it when ready to resume.

Once it has heard enough, Dragon takes a moment to process the acoustic information you just provided and to create your User profile.
“Adapt to writing style” - and a caution for multilingual users

Dragon will then offer to start adapting its Vocabulary, presenting a screen entitled “Adapt to your writing style”. Feel free to skip this simplified customization, which analyzes the texts in your My Documents folder as well as your sent e-mails; as soon as your profile is created, you can use the powerful, targeted customization tools described in the following lessons.

IMPORTANT: If some of your documents and emails are in a foreign language or in a radically different style (think Chaucer or Shakespeare), adapting to these “foreign” texts could actually lower the accuracy, so do skip this automatic step. The Accuracy Center will let you indicate the specific documents you want Dragon to adapt from.

The Speed vs. Accuracy slider and Natural Language Commands

When you start using Dragon 10, the program may present you with a special message if it determined that your computer’s characteristics wouldn’t allow optimal performance. It will inform you that it has adjusted the defaults for two of its settings:

- the Speed versus Accuracy slider, and
- Natural Language Commands for Microsoft Word, Excel, PowerPoint, and Corel WordPerfect. (The lesson “Controlling your Desktop and Applications” covers these large sets of flexible commands.)

If desired, you can easily reverse these changes through Dragon’s Options dialog; you can enable or disable the Natural Language Commands for any of these four applications individually, and you can experiment with various settings of the slider, depending on whether speed of response is more important in your situation. The Help provides more details, and its Performance Assistant offers many suggestions for optimizing Dragon's speed on your computer.

Having given the information needed to create your User profile, you could now start dictating. Before you do, though, we strongly recommend that you begin personalizing the Vocabulary, since this plays a crucial role in accuracy and efficiency—this workbook will walk you through easy steps to do just that.

Key points about creating a User profile

- Each person who wants to dictate with Dragon first needs to create his or her own User profile; this is a short process, guided through a series of screens called the New User Wizard.

- Be sure to choose the appropriate dictation source in the first screen of the New User Wizard. The online Help contains details on special sources like recorders and USB, wireless, or array microphones.

- You can “enroll” an additional dictation source for an existing profile (for instance, to be able to dictate into a recorder or an array microphone sometimes). Your various dictation sources will benefit from the same Vocabulary customizations (special words and phrases, pronunciations, spellings, etc.).

- When reading the acoustic training text, speak clearly but naturally, using the same volume, pitch and pace you’ll use day-to-day. Try to read exactly what is prompted as if you were dictating it. Use the Pause button if you need to clear your throat or speak to someone... When its microphone is on, Dragon listens to every sound coming from the microphone’s listening side!

- “Adapt to Writing Style” is an optional step: Dragon adapts its vocabulary to text it finds in your My Documents folder as well as sent e-mails. (It is meant to introduce the importance of vocabulary customization.) For best efficiency, skip it; this workbook will present you Dragon’s more targeted and powerful tools.
Learning More and Getting Help

Dragon NaturallySpeaking offers so many tools, commands, and features that it would be impossible to provide all their details in this workbook. This lesson presents several ways to find more information as you start using the software—be sure to take advantage of the available resources!

Note: We welcome comments about this workbook and all aspects of Dragon documentation (Quick Start Card, User Guide, Tutorial, Tip of the Day, Help menu, Performance Assistant, “What Can I Say” windows…). Please use the Product Feedback/Feature Request form at www.nuance.com/naturallyspeaking/contact.

The Dragon User’s Guide

The User’s Guide is available as a color PDF file on your product disk, and revisions are posted regularly on www.nuance.com. (When viewing the PDF file, you can click chapter headings to jump to specific topics, and you can print out sections as well as the entire file.)

The Accuracy Center and Accuracy Assistant

The Accuracy Center offers a central location to access many tools, and get guidance on which tool to use.

Step 1: Say Open Accuracy Center or say Switch to DragonBar, then Tools, then Accuracy Center.

Step 2: Click or say the name of the link that interests you.

TIP As in supported Web browsers, you can activate links without saying their whole name: for instance, instead of add a list of words to your vocabulary, you could say just add a list.

The link “Which tool should I use?” opens the Accuracy Assistant, which presents a set of questions to help determine what you can do to improve accuracy in a given situation.
The Online Help and Performance Assistant

The DragonBar’s Help menu gives you access to the on-screen Help topics and the Performance Assistant (as well as the Accuracy Assistant, the Sample Commands window, and the Tutorial.) You can also access the Help by saying give me help at any time; try it soon!

You can browse the Help topics, or search for specific keywords—for instance, entering the word “punctuation” brings up topics including “Dictating punctuation and symbols” and “Selecting characters and words.” You can also print topics of your choice.

IMPORTANT: Dragon also provides contextual help: the Help button on the program’s dialog boxes takes you directly to the relevant topic in the Help.

The Sample Commands window: “What Can I Say”

At any time, you can ask Dragon to display a sample of the commands you might use.

When a popular application such as Microsoft Word or Excel is active, this window will show commands designed for that application. Otherwise, it will show a list of global commands — commands you can use no matter what application is currently active.

Step 1: Say open Sample Commands, or what can I say or, on the DragonBar, click Help > Sample Commands.

Step 2: A narrow window opens, displaying some of the commands available in the current context, as well as instructions. You can access the links and tabs by clicking them or saying their name.

TIP To see additional commands, you can use the Help as well as the Command Browser, which is accessible via the Tools menu or commands such as Open Command Browser.
Key points about learning more and getting help

✓ This workbook is meant to get you started efficiently. You can learn more, get help, and find answers to many questions, by using the User’s Guide, the online Help, the Sample Commands window, the Accuracy Center, the Accuracy Assistant, the Performance Assistant, as well as the Nuance website (www.nuance.com), including the Knowledge Base of “Tech Notes”, updated regularly.

✓ You can ask Dragon for help at any time by saying commands like: what can I say, give me help, launch the help topics, open Accuracy Center, computer improve my accuracy...

An experienced Dragon trainer can offer specific guidance and customization; consulting one is particularly efficient for users who have special environments, workflows, equipment, or challenges (related, for instance, to motion, vision, reading or speech fluency)...

Now that you know how to access many resources, let’s learn Dragon’s most important aspects; we’ll start with an often-overlooked but crucial one, Vocabulary customization.
Why Customizing the Vocabulary is Important

Transcribing a person’s speech presents acoustic challenges, such as accents and ambient noise. There is also a lexical challenge; for the transcription to be precisely accurate, familiarity with the terms used is necessary. Even an experienced legal secretary would have trouble transcribing an insurance executive’s dictation, for instance! And a newly-hired transcriptionist would have to get used not only to the dictators’ voices, but also to learn the correct spelling and formatting of what they mention, including acronyms, abbreviations, special phrases, names of people, places, products, etc.

An unusual name may seem commonplace to you because you use it frequently, but a person who hears it for the first time may not be able to recognize and spell it: that name is not yet a part of this person’s vocabulary. Similarly, if a word or phrase is not in Dragon’s active vocabulary, the software cannot transcribe it correctly without a little instruction.

When you created your User profile, you provided acoustic information which Dragon incorporated into its acoustic model. To get optimal accuracy, you should also help the software adapt its language model and Vocabulary.

Lexical customization ensures that what you dictate is transcribed with the desired spelling, spacing, and even capitalization; Dragon provides many powerful tools for it, so this important investment need not take much time. The Help contains much information about personalizing the Vocabulary—including how you can even benefit from the customizations done by colleagues.

Key points about Vocabulary customization

✓ As soon as you have created a User profile, you could start dictating. However, customizing the Vocabulary right away is efficient since it helps Dragon “get it right the first time” (including spelling, capitalization, and spacing) and it needn’t take much of your time. Personalizing the Vocabulary (early and often) is strongly recommended. The following pages will show you how.

✓ Dragon offers many simple and powerful Vocabulary tools to allow you to make your dictations faster and more convenient.
Customizing the Vocabulary—Using the Vocabulary Editor

Dragon’s Vocabulary Editor lets you view what can be transcribed from the computer’s active memory; it also allows you to add new entries, as well as edit existing entries—including their Spoken Forms and Properties.

Let’s take a look inside the Vocabulary and discover the Vocabulary Editor’s interface:

Step 1: Say Edit Vocabulary (you can also click View/Edit on the DragonBar’s Words menu or View or Edit Your Vocabulary from the Accuracy Center). The Vocabulary Editor opens; its scrollable window lists the entries currently in the active Vocabulary.

Take a moment to scroll through the list. You will see names of people, places, institutions and products, as well as common words, phrases, and abbreviations. Most entries only have a Written Form (left column), but some also have a Spoken form (right column)—this is an important feature, as you will see.

Step 2: Open the Display drop-down list and choose Words Containing Spaces.

Other Vocabulary displays include Words Containing Digits, Words Containing Capitalization, and Words with Special Properties. By browsing these, you can learn more about what the software uses to transcribe your dictation. You also get ideas about what entries you might add or edit.

Adding Vocabulary Entries: Words, Phrases, Acronyms...

You can quickly search for a particular Vocabulary entry by entering it in the Written Form field. If it appears in the scrollable list, it is already in the active layer of the Vocabulary. If not, say or click Add to bring it in.

CAUTION When adding an entry to the Vocabulary, be sure to spell and capitalize it correctly! Otherwise, it will appear misspelled in your documents every time you dictate it.
Some of the “words” in the Vocabulary Editor aren’t single words. Of course is listed. So is as well as. Some of the multi-words are names of people, places, products, and institutions: Mother Teresa, Madison Square Garden, KitchenAid, Brigham and Women’s Hospital, Marine Corps, Library of Congress, Babe Ruth, Accounts Payable, George Washington, Johnson & Johnson, Division I, LAN Server…

These help the software resolve spelling and capitalization ambiguities: if the Vocabulary didn’t contain the phrase Mother Teresa, the dictation would probably appear as “mother Theresa”—because the word mother is usually not capitalized, and because Theresa is the more common spelling of the name. Having the phrase in its Vocabulary helps Dragon choose the desired capitalization and spelling.

Also, recognizing long sounds is easier than very short sounds. A and the are acoustically very similar, as are in and an. Longer words, like “chrysanthemum”, contain more acoustic information.

We strongly recommend adding personal multi-words; they will save you time—you will not have to adjust spelling and capitalization after transcription.

Exercise 1: In the Vocabulary Editor, look for a few familiar names such as your own, the names of your town, company, colleagues or relatives; if necessary, add them.

TIP Consider adding nicknames (alone or in combination) and diminutives as well as formal names, particularly for names that can be spelled different ways: for instance, one might add Liz Hansen, Elizabeth McGee Hansen, Jennifer B. Addams, Jennifer Addams, Jenny Addams, Jenn Addams, Judge Addams, Scooter Addams…

This idea applies to more than just names; whenever you add an item to the Vocabulary, think of its possible variations: singular/plural for nouns, present/past/gerund for verbs… Remember, if something is not in the Vocabulary, the software cannot recognize it, so don’t hesitate to add!

Exercise 2: Open DragonPad and start a list of Vocabulary entries relevant to you; some suggestions are below. (Soon you will learn how to import these entries all at once.)

- jargon and phrases specific to your profession (such as distro, site visit and non-State)
- names of places, facilities or organizations (such as Building 52, or County Adoption Center)
- names of products (such as MicroPore tape or Latex Exterior Semi-Gloss)
- acronyms, part numbers, codes (such as FICA, 501c(3) or RX-70y)
- names of people (coworkers, clients, friends, relatives…) including full combinations for names that could be spelled differently (Kristin, Gene, Steven, McGregor, Wolfe…) or are very short (Kip, Kit, Dee…) since this helps Dragon resolve acoustic ambiguities.

TIP Your employer may be able to give you some lists that could save you time, particularly if they are already in electronic form: lists of staff or clients, departments, units or divisions, products, trademarks, building names, as well as glossaries of terms and acronyms. Starting from such lists doesn’t just save time, it may also help add these items with their official, correct spelling!

The importance of Spoken Forms

Radio programs tell their callers “let us know how to pronounce your name”; a reason is that some names could be pronounced in several ways, and some are not pronounced “the way they are written”, because of silent letters for instance. Acronyms are often pronounced letter by letter, but not always: ASAP is pronounced “ay sap” by many people. These facts are addressed by an important Dragon feature: Spoken Forms.

From the Display drop-down list of the Vocabulary Editor, choose “Words with spoken forms only”. Take a moment to scroll through and look at existing spoken forms—you will get ideas for what kinds of entries warrant them and how they can be written.
**TIP** Vocabulary entries may have more than one spoken form. You may add spoken forms to custom entries and to existing entries, in order to be able to dictate them as comes naturally to you—for example, to obtain the symbol ©, you might like to say “circle see” instead of the existing spoken form “copyright sign”.

Adding Spoken Forms allows you to dictate in the way that is *most natural*, but also *quickest* for you. In addition to indicating pronunciation, Spoken Forms can be used for “vocal shorthand” and automatic substitution: you say something short and easy, and Dragon types something longer or “trickier” to say or remember. You will many examples in this workbook. This capability can be used to give consistency and clarity to your writings; groups can take advantage of it to help everyone easily comply with recommendations like avoiding abbreviations and potentially confusable items.

**To add a Spoken Form via the Vocabulary Editor:**

**Step 1:** First, decide what you want to say, and what Dragon should transcribe when you say it.

For example, suppose your school Central Lexington United High School is often called CLUHS or “cluss”. When you dictate “cluss”, do you want Dragon to type *CLUHS* or *Central Lexington United High School*?

**Step 2:** In the Written Form field, type what you want Dragon to write. Be careful with its capitalization, spacing, and spelling — including symbols or punctuation marks if needed, as in E*TRADE.

**Step 3:** In the Spoken Form field, type what you will actually say. In some cases (as in our “cluss” example), you will enter one or more “made-up words” to represent the desired sound.

**Step 4:** Say Add or press Enter.

If you entered a “made-up word” in the Spoken Form field, Dragon brings up a dialog box to tell you that it doesn’t know that word and will therefore guess its pronunciation — this gives you a chance to catch any typo you may have made in the Spoken Form.

**TIP** Entries containing *symbols*, *digits*, or *unusual spacing* are particularly likely to warrant a Spoken Form.

If you add e-mail addresses to the Vocabulary, giving them a Spoken Form can make them quicker to dictate: for instance, for *AmyT&JohnB@yahoo.com*, “Amy and John at yahoo dot com” or even just “Amy and John at yahoo”.

---

**TIP** Vocabulary entries may have more than one spoken form. You may add spoken forms to custom entries and to existing entries, in order to be able to dictate them as comes naturally to you—for example, to obtain the symbol ©, you might like to say “circle see” instead of the existing spoken form “copyright sign”.

Adding Spoken Forms allows you to dictate in the way that is *most natural*, but also *quickest* for you. In addition to indicating pronunciation, Spoken Forms can be used for “vocal shorthand” and automatic substitution: you say something short and easy, and Dragon types something longer or “trickier” to say or remember. You will many examples in this workbook. This capability can be used to give consistency and clarity to your writings; groups can take advantage of it to help everyone easily comply with recommendations like avoiding abbreviations and potentially confusable items.

**To add a Spoken Form via the Vocabulary Editor:**

**Step 1:** First, decide what you want to say, and what Dragon should transcribe when you say it.

For example, suppose your school Central Lexington United High School is often called CLUHS or “cluss”. When you dictate “cluss”, do you want Dragon to type *CLUHS* or *Central Lexington United High School*?

**Step 2:** In the Written Form field, type what you want Dragon to write. Be careful with its capitalization, spacing, and spelling — including symbols or punctuation marks if needed, as in E*TRADE.

**Step 3:** In the Spoken Form field, type what you will actually say. In some cases (as in our “cluss” example), you will enter one or more “made-up words” to represent the desired sound.

**Step 4:** Say Add or press Enter.

If you entered a “made-up word” in the Spoken Form field, Dragon brings up a dialog box to tell you that it doesn’t know that word and will therefore guess its pronunciation — this gives you a chance to catch any typo you may have made in the Spoken Form.

**TIP** Entries containing *symbols*, *digits*, or *unusual spacing* are particularly likely to warrant a Spoken Form.

If you add e-mail addresses to the Vocabulary, giving them a Spoken Form can make them quicker to dictate: for instance, for *AmyT&JohnB@yahoo.com*, “Amy and John at yahoo dot com” or even just “Amy and John at yahoo”.

---

**TIP** Vocabulary entries may have more than one spoken form. You may add spoken forms to custom entries and to existing entries, in order to be able to dictate them as comes naturally to you—for example, to obtain the symbol ©, you might like to say “circle see” instead of the existing spoken form “copyright sign”.

Adding Spoken Forms allows you to dictate in the way that is *most natural*, but also *quickest* for you. In addition to indicating pronunciation, Spoken Forms can be used for “vocal shorthand” and automatic substitution: you say something short and easy, and Dragon types something longer or “trickier” to say or remember. You will many examples in this workbook. This capability can be used to give consistency and clarity to your writings; groups can take advantage of it to help everyone easily comply with recommendations like avoiding abbreviations and potentially confusable items.

**To add a Spoken Form via the Vocabulary Editor:**

**Step 1:** First, decide what you want to say, and what Dragon should transcribe when you say it.

For example, suppose your school Central Lexington United High School is often called CLUHS or “cluss”. When you dictate “cluss”, do you want Dragon to type *CLUHS* or *Central Lexington United High School*?

**Step 2:** In the Written Form field, type what you want Dragon to write. Be careful with its capitalization, spacing, and spelling — including symbols or punctuation marks if needed, as in E*TRADE.

**Step 3:** In the Spoken Form field, type what you will actually say. In some cases (as in our “cluss” example), you will enter one or more “made-up words” to represent the desired sound.

**Step 4:** Say Add or press Enter.

If you entered a “made-up word” in the Spoken Form field, Dragon brings up a dialog box to tell you that it doesn’t know that word and will therefore guess its pronunciation — this gives you a chance to catch any typo you may have made in the Spoken Form.

**TIP** Entries containing *symbols*, *digits*, or *unusual spacing* are particularly likely to warrant a Spoken Form.

If you add e-mail addresses to the Vocabulary, giving them a Spoken Form can make them quicker to dictate: for instance, for *AmyT&JohnB@yahoo.com*, “Amy and John at yahoo dot com” or even just “Amy and John at yahoo”.
Deleting “Words” and Modifying “Word” Properties

If at some point you find that an item is not transcribed as you wished, remember that it might need a spoken form, or a longer entry in the Vocabulary. (Also, particularly if the pronunciation contains non-English sounds, you may want to help the software with some acoustic “training”—see “Training Words”).

You may also run into cases where a word you need is consistently transcribed as another word: if that other word is not important to you, deleting it from the Vocabulary Editor will solve the conflict by removing your desired word’s “competition”. The names Schafer, Shaffer, Schaefer and Shafer all sound alike, for instance.

Note: Dragon comes with literally thousands of Vocabulary entries; as you browse the Vocabulary Editor, you will see many you are very unlikely to ever dictate, but don’t spend time deleting them unless they actually cause a conflict!

TIP There’s more you can do in the Vocabulary Editor!

For instance, by clicking the Properties button, you can view or change the capitalization, spacing and numeral properties of an entry.

In the Word Properties dialog box, you can also choose one or even two alternate written forms: for instance, if you prefer the word “figure” to be written as “Fig.” when before numbers (Fig. 3).

IMPORTANT You would also use the Word Properties dialog for the dictation command “new line”, if you want it to trigger capitalization of the following word (see the lesson “Starting to Dictate”, page 21.)

Your documentation provides more details; in particular, take a look at the Help topics “The Vocabulary Editor Dialog Box”, “Deleting words”, and “The Word Properties dialog box.”

Key points about the Vocabulary Editor

✓ You can access the Vocabulary Editor with a command like edit vocabulary, through the Accuracy Center, or through the Words menu of the DragonBar.
In the Vocabulary Editor, custom-added entries are marked with a red star; choosing Custom Words Only from the Display drop-down list allows you to see just the custom entries.

You can locate an item by entering it in the Written Form field. By using the Display drop-down list, you can also browse subsets like “Custom words only”, “Words containing digits” and “Words containing punctuation.”

Spoken Forms are an efficient way to help Dragon transcribe “special” words. You can view many examples of Spoken Forms in the Vocabulary Editor. In addition to clarifying pronunciation (particularly useful for items that contain digits, symbols, or silent letters), Spoken Forms can be used to allow the speaker to say something quite different, and much shorter and easier, than their associated written form: you say just “E O B stat”, for instance, and Dragon types “Explanation of Benefit (EOB) statement.”

A Vocabulary entry can have several spoken forms, and alternate written forms.

If a Vocabulary entry you don't need “competes” for recognition with something you do need to dictate, you can delete that entry from the Vocabulary Editor.

You can view or change the special Properties of Vocabulary entries, including spacing and capitalization. In the Vocabulary Editor, entries whose properties were modified are marked with a blue star.
Importing Lists of Vocabulary Entries

You now know how to add words and phrases one by one in the Vocabulary Editor. If you have many entries to add, this is not the most efficient method, particularly if you already have some relevant lists in electronic form. Dragon’s Word Import feature allows adding many Vocabulary entries at once, even if they have Spoken Forms.

Observe the sample import list in the illustration below, and identify the motivation behind each entry.

Steps to create and import one or more lists of “words” (i.e. Vocabulary entries):

Step 1: Create a document (or edit an existing document) listing entries to add to the Vocabulary. You can do it in any word processor as long as you can save this document as plain text.

- Have each entry on a separate line.
- Make sure everything is spelled, capitalized and spaced correctly.
- To include a Spoken Form, follow the Written Form with a backslash (\), then the Spoken Form: for example, Grb II\grab two.

Step 2: After saving this document as a plain text (.txt) file (File > Save As -- then, depending on what word processor was used, you will choose Text Document, Text Only, or Plain Text), close it.

Repeat as necessary with other lists (many find it convenient to make several lists, by category: a list of friends, a list of professional contacts, a list of product names, a list of local landmarks...).

Step 3: Say import custom words or, on the DragonBar, click Words, Import.
Step 4: On the Add Words from Word Lists dialog, click the Add File button.

The Add File window appears. Locate the file containing your list and click Open; the name of the file you designated is now displayed in the File List.

If you have other lists to import, add their files in the same way.

Step 5: Click Next. The software will import the listed items into the Vocabulary.

The imported entries will be viewable in the Vocabulary Editor, where they will have a red star like other custom entries.

Key points about importing lists of Vocabulary entries:

- You can add whole lists of Vocabulary entries at once. Prepare the list(s), then open Dragon’s list import dialog (you can say import words or choose from the Accuracy Center or the Words menu).
- Word lists must be saved as plain text, and closed, before they can be imported.
- Each word list entry must be on its own line.
- To specify a spoken form in a word list, use a backslash (\) to separate it from the written form.
Customizing the Vocabulary from Existing Documents

You now know about importing lists of entries into the Vocabulary. Another efficient way to boost your accuracy is to let Dragon analyze text that is similar to what you are likely to dictate: the Add Words From Documents tool uses many documents at once to “harvest” potential words to add to the Vocabulary, as well as to “adapt to the writing style” (i.e., learn frequency information). The greater the amount of relevant text Dragon gets to analyze, the better it can adapt its Vocabulary to what you usually need to dictate. (This is similar to giving a just-hired transcriptionist many documents in which to observe the terms used, their spellings, the words that often appear before or after, etc.; doing so would help the transcriptionist get ready to transcribe your dictations most accurately, right from the start.)

Dragon can perform its text analysis on files of the following types: .txt (plain text), .rtf (Rich Text), .doc(x) (Microsoft Word), .wpd (Corel WordPerfect), and HTML formats.

TIP If significant text exists only in an application that doesn’t normally produce files of these types (PowerPoint is an example), see whether this application lets you copy text so you can paste it in the DragonPad and save it from there, or whether it offers a way to extract plain text (it could be called “export” or “save as outline” for instance.) Also, if essential text only exists as PDF or in paper form, consider using Optical Character Recognition software such as OmniPage to convert into one of the accepted formats.

Step 1: Locate some electronic documents you have written—think of reports, letters, memos, proposals... (As long as they are similar to what you intend to dictate, you can also use documents written by someone else.) The more closely these documents match the dictation you will usually be doing, the better.

Step 2: Spell-check the documents if necessary (since Dragon would detect misspellings as unknown words.) In addition, remove any foreign-language sections that might be present. Then, make sure the documents are closed.

TIP The Help contains more details on this tool, including how to best prepare documents for analysis.

Now that you have a sample of text similar to your intended dictations, let’s launch the tool and designate this sample for analysis. (If you obtain more documents later, you can run the tool again.)

Step 3: Say add words from documents or choose that link in the Accuracy Center.

Make sure that the box “Preview the list of unknown words” is checked, and click Next.

The checkbox “Adapt to writing style” is what makes Dragon learn frequency information, which increases accuracy since it helps differentiate between sound-alikies, like “world” and “whirled”. Leave this box checked unless you only want to “harvest” potential custom words—for instance, if the text is very different from your normal style, or contains a foreign language.
Step 4: On the Add Documents box, click Add Document. Locate and select the document(s), then click Open.

**TIP** You can select multiple files at once: by holding down the Ctrl key, by pressing Ctrl A (the Windows keyboard shortcut to “select all”)... Dragon will now analyze the text contained in the designated documents. This may take a moment—if there is a lot of text to analyze, you should run this tool when you do NOT need to use Dragon for something else.

![Add Words from Documents](image)

Once Dragon indicates that analysis is complete, click Next.

Dragon will then present you with a list of the “unknown” words it found, with a checkbox next to each one, and the number of time encountered (the ones found most frequently are presented at the top, since they are most likely to be relevant, unlike those that only occurred a few times.)

Step 5: Uncheck items you do NOT wish to add (you can take advantage of the Uncheck All button.)

**TIP** This list may include capitalized forms of common words; these are usually better left out of the Vocabulary since you can always say “Cap” before a word, but you may want to include them in a phrase entry, such as ‘Senior Technical Trainer’ (remember, it’s a good idea to add phrases to the Vocabulary).

If you wish to modify an item (to make it lowercase, or expand on it, for instance) or give it a spoken form, highlight it then click or say **Edit**. This button opens the **Edit Word** window, which also presents a little context for the item.
Before the words are added, you are given the option to provide acoustic training for them. You can skip this step and provide training later just for those words that seem to need it, as explained in this workbook and in the Help.

Finally, Dragon will adapt its word-frequency and context information based on the text analyzed (unless you unchecked the box “Adapt to writing style” on the first screen of this tool); this will allow it to better guess between words that sound alike.

**Key points about customizing the Vocabulary from documents:**

- **Add Words From Documents** is one of the Vocabulary tools accessible from the Accuracy Center.
- This tool can analyze existing documents to learn about the “writing style” you plan to use—meaning, which words are used with what frequency, and what words appear near each other. You can also use as input documents written by someone else, as long as they are similar to what you will dictate.
- To be used in this tool, files must be of .txt, .rtf, .doc, .wpd, or .html formats.
- The tool can process many files at a time. You may wish to re-run it whenever you create or find suitable text. The more (relevant) text is processed, the more refined your profile can become.
- When presented with the unknown words the tool found in the texts, you can choose which ones to add, and, thanks to the Edit button, modify their spelling and capitalization as well as give them a Spoken Form if warranted.
- After adding to the Vocabulary items you are likely to dictate, letting Dragon see how often and next to what you are likely to dictate them helps pre-empt recognition errors.
- Add Words From Documents is only one of the ways Dragon can adapt; you can learn others in this workbook as well as in Dragon’s Help.
Customizing the Vocabulary from Your E-Mail

As you learned, Dragon can adapt its Vocabulary based on designated documents. It also has the ability to quickly learn from your usage of several e-mail programs: Lotus Notes, Microsoft Outlook, Outlook Express, and Windows Mail. By “studying” the e-mails you sent as well as the recipient names, Dragon can identify potentially useful contact names to add to the Vocabulary, as well as adapt its statistical information on word usage (frequency and context).

You should take advantage of this tool as soon as possible after creating your User profile.

**Step 1:** Say open Accuracy Center, then say or click the link **Increase accuracy from e-mail.**

**Step 2:** The tool will detect supported e-mail programs installed on your computer and display their names (this may take a moment). Check the box of the e-mail program(s) you want Dragon to analyze here.

**Step 3:** Use the checkboxes to indicate whether you want Dragon to only look for **contact names** to potentially add to the Vocabulary, or whether you also want Dragon to **adapt its statistics** based on your sent mail.

The option to “Improve from my e-mail writing style” is recommended **EXCEPT** if what you sent in that e-mail program contains another language.

Note: The analysis may keep Dragon busy for a while, especially the first time; later on, it will go much faster if you choose the option button “Consider e-mail written since my last scan.”

**IMPORTANT:** When you start this process, your e-mail program may bring up a message box for you to allow Dragon to access it; if you have several windows open, this message may not be visible initially because it is under another window.

**Step 4:** After its analysis, the tool will display what it identified as potentially useful additions.

The rest of the process is similar to Add Words from Documents: you can uncheck items, edit items, and train items acoustically if you wish, then Dragon adds to the Vocabulary the checked items, plus adapts its model to the word frequencies observed, if you opted for that.
Key points about customizing the Vocabulary from e-mail:

- Dragon can quickly adapt its Vocabulary from your use of e-mail in Lotus Notes, Microsoft Outlook or Outlook Express, thanks to a tool available in its Accuracy Center: Increase Accuracy From E-Mail.

- This tool is presented much like the tool Add Words From Documents. It performs two functions: it finds and lists potentially useful contact names to add, and it also analyzes your sent e-mails to “adapt to the writing style”, i.e. to refine the word usage information in the Vocabulary's Language Model.

- Use this tool as soon as possible, then launch it every so often so Dragon can learn from any new emails or contacts you have created. Remember that Dragon needs to “know about” your contacts in order to transcribe their name correctly—this is particularly important for Version 10’s direct commands “write email to...” and “schedule meeting with...” (available in editions Professional and above).
Starting to Dictate: Controlling the Microphone

When ready to dictate, you must ensure that Dragon NaturallySpeaking is able to hear you. Your device must be connected and positioned correctly of course, but the software also needs to know whether to “listen”. This lesson shows several ways to indicate that, and introduces the DragonBar—Dragon’s own “tool bar”.

The DragonBar and the Microphone Icon

The DragonBar appears by default as a floating horizontal window in Version 10 (you can change its appearance: for instance, in the Options dialog’s View tab, you can choose to have it docked to the top of the screen, which was the default in previous versions.)

It contains several menus, a message area, and a microphone icon, which is horizontal when the microphone is off. If you click this icon, it becomes vertical and the sound meter next to it turns yellow, indicating that the microphone is on and Dragon is ready to listen. You can now click the icon to turn the microphone off. This is just one way to control whether Dragon’s microphone is on or off.

TIP  Dragon’s microphone icon is also available in your system tray (on your Windows Taskbar, usually in the lower-right, near the time display).

Voice Commands for the Microphone and Sleep State

One can turn off the microphone by saying the command microphone off. There is no command to turn the microphone on, since when the microphone is off, it can’t “hear” anything! There are, however, commands to put the microphone in and out of a sleeping state, where it doesn’t transcribe your words, but it is still listening.

To try this, turn the microphone on by clicking on its icon, then say stop listening or go to sleep.

IMPORTANT  For these and all voice commands, there should be a brief silence before and after, but none in the middle, otherwise the program cannot recognize the command and instead transcribes the words. For example, make sure you say the words “go to sleep” together in a natural flow, not “go… to… sleep”.

Putting the microphone to sleep is useful when you need to “put on hold” Dragon for a moment. However, leaving it in that state for a long time is not recommended, so do turn the microphone off if you will not be dictating for a while (and are physically able to turn on the microphone manually.)

TIP  You can set Dragon to always open your User profile with the microphone asleep, waiting for your command to “wake up”, so that no manual action is needed to turn it on: in the Options dialog box, on the Miscellaneous tab, select Microphone on (asleep) under User Open.
The Importance of Hot Keys, including Microphone On/Off

Pressing a key or two is usually quicker than moving and clicking the mouse (and physically easier, too)—software programs, including operating systems, typically contain keyboard shortcuts, or ‘hot keys’. Dragon provides hot keys for various useful tasks, including controlling the state of its listening.

If your computer has a full-sized keyboard, press the plus (+) key on the numeric keypad (on the far right of the keyboard). Pressing this key turns the microphone on, and then pressing it again turns it off.

If your computer does not have a numeric keypad, or you wish to keep the plus key for other use, designate a new key to serve as the microphone on/off hot key. This is done through Dragon’s Options dialog box:

Step 1: On the DragonBar, click Tools, then Options (you can also say open options dialog). Click the tab labeled Hot Keys (you can also say Hot Keys).

Step 2: Click the button Microphone On/Off. A window entitled Set Hot Key appears.

Step 3: Press the desired key or key combination (F10 is typically a good choice), then say OK or press Enter. (If this key is already assigned in another application, Dragon will tell you.)

Step 4: You are back in the Options dialog box. Click Apply, then OK.

Note that Dragon also offers a hot key to toggle the microphone between sleep and listening.

Key points about controlling whether Dragon “listens”

✔ Dragon “listens” whenever its microphone is on. Remember to turn the microphone off (or put it into its sleeping state if appropriate) when you are not dictating, like before answering the phone, speaking to someone, or clearing your throat; this is a simple but important habit you should develop quickly.

✔ Pressing its hot key is usually the fastest and most convenient way to turn the microphone on and off; you can also click the microphone icon on the DragonBar or in the System Tray.

✔ You can change any of Dragon’s default hot keys, including the microphone’s, in its Options dialog (say Open Options Dialog, then Hot Keys).

✔ You can turn the microphone off by saying microphone off, but then the mouse or keyboard need to be used to turn it back on. You can say go to sleep or stop listening to put the microphone into a sleeping state and then say wake up or listen to me when you wish to dictate again.

✔ Microphone off, stop listening, go to sleep, listen to me and wake up are all voice commands. In order for Dragon to recognize and execute the desired action, you must pause slightly before and after but not in the middle of the command.
Starting to Dictate: Your First Dictation

You can use Dragon NaturallySpeaking to dictate into virtually any Windows application. Further in this workbook, you will learn how to start programs by voice (but one doesn’t need to have started a program by voice in order to dictate into it.)

What you dictate will be inserted wherever your insertion point (cursor) is located in your document. There are many ways of moving the insertion point by voice, but know that you can also re-position it by hand (clicking the mouse where you want it, or using your keyboard’s arrow keys) just as you normally would.

**TIP** Before dictating, make sure the desired window is active (its title bar should not be dimmed), and the insertion point is where you want your dictation to appear. (Your operating system can make such visual elements easier to see; Windows XP’s Accessibility Wizard, under Start>Programs>Accessories, walks you through various items that can be helpful, such as increasing the thickness of the insertion point.)

Dictating Text and Punctuation Marks

Here are the most common punctuation marks, followed by what you say to “voice-type” them:

- . period
- , comma
- ? question mark
- ! exclamation point or exclamation mark
- : colon
- ; semi-colon

For these exercises, start a word processor (like DragonPad—say start DragonPad).

**Exercise 1:** Look at the following sample, dictate it, then say microphone off. (If any word is misrecognized, ignore it for now.) The very first words may take a moment to appear on the screen; this is normal.

| How is this different from dictating to a person? I should try to provide clean input: speaking naturally, but without mumbling or trailing off? |

**CAUTION** Do turn off your microphone when you finish dictating! If your last sentence reads something like “trailing off! Microphone off”, you probably forgot to pause briefly before giving the command.

New Line and New Paragraph

When typing, you use your Enter key to start a new line or new paragraph. With Dragon active, you can still press your Enter key (or any other key on your keyboard), but you can also simply say commands like new line or new paragraph.

**Note:** When you start dictating your new paragraph, Dragon will capitalize its first letter automatically, just like it automatically capitalizes after a period, an exclamation point, or a question mark. By default, Dragon does NOT capitalize the first word after you say the command new line.

**TIP** If you prefer new line to trigger capitalization, you can change its default via the Vocabulary Editor, since new line belongs to a special group of commands accessible there; these so-called dictation commands, such as “Cap”, “Caps On” and “Numeral”, appear near the very top of the Vocabulary Editor’s list, with a blank Written Form field. To find them quickly, change the Display drop-down list to “Word with spoken forms only”. Once you’ve highlighted new line in the Vocabulary Editor, say or click Properties, then choose “capitalized” from the drop-down list “Format the next word”.
The Results Box

Exercise 2: Study the following text sample then dictate it in DragonPad. (Ignore any errors for now.)

The more I use it, the software will adapt to the way I sound and the words I use. At the same time, I will also acquire good habits like pausing optimally, keeping silent when hesitating, and turning the microphone off, or putting it into its sleep state, when necessary!

As you may have noticed, the following happens when you dictate sentences:

- Your words first appear in a small horizontal rectangle. This is called the Results Box.
- Words accumulate in the Results Box until you pause, at which point they appear in your document. If many words are dictated without a pause, the Results box automatically stretches out.
- The contents of the Results Box sometimes change as you speak; what first appears there may not be what is inserted in your document, since Dragon sometimes revises its original guess based on subsequent words.

Dragon uses the contents of the Results Box to best guess what exactly it should transcribe; this is particularly important for sounds that can be spelled in different ways, like “to” and “too”. If you speak single words, or only a few words at a time, the software has few or no contextual clues. For this reason, long continuous “utterances” can be recognized more accurately than short ones (and long words better than short ones).

**IMPORTANT** Try to formulate your sentences and commands before you start dictating them. This can be challenging at first, particularly for those who have been “thinking through their fingers” for years, but you’ll develop the habit once you see what a difference it makes.

Exercise 3: While looking at the Results Box, dictate four sentences on a topic of your choice. (For now, ignore any errors.)

Did you forget to dictate punctuation in this paragraph? It can be harder to remember when we are “composing out loud” but, with practice, it will become second nature.

**TIP** You can take advantage of Dragon’s option to automatically insert commas and periods as you dictate—see Formatting under the DragonBar’s Tools menu. The Help contains details about this “Natural Punctuation” option and the commands to turn it on and off.
IMPORTANT: The location and behavior of the Results box can be customized from the Options dialog’s View tab. Many users find it most convenient to “anchor” the Results box to a place where it’s unlikely to hide anything, such as the bottom right corner of their screen—to do that, just check the “Anchor” checkbox, then drag the Results box to the desired place.

Below are other frequent punctuation marks—you may want to say them out loud once before the next exercise. Note in particular the ellipsis and the difference between dash and hyphen.

Remember that you can use the Vocabulary Editor to see punctuation and symbols with their existing spoken forms, as well as to add your own spoken forms, and to modify properties (such as “having no following space” like the open quote.)

```
“ open quote ... ellipsis
” close quote & ampersand or and sign
( open paren or open parenthesis -- dash
) close paren or close parenthesis - hyphen
```

TIPS for HYPHENS

You don’t always have to say hyphens: thanks to its built-in Vocabulary, Dragon is able to include hyphens when you say items like 3-year-old, above-mentioned, after-tax, ad-libbed, ankle-length, anti-infective, as well as famous hyphenated names like Abdul-Jabbar. (To see many, you can choose “Words containing punctuation” in the Vocabulary Editor’s dropdown list “Display”.)

You can prevent Dragon from entering a hyphen by pausing, or saying “spacebar,” where the hyphen would be.

Exercise 4: Dictate the following sample (if any misrecognitions occur, ignore them for now.)

| These lessons remind me that "practice makes perfect." (Who said this, Confucius?) |
| When it comes to speech-recognition software, truer words were never spoken… |

TIP When one turns the microphone off, Dragon may still be working on the last sounds it heard. Be patient—remember, the microphone toggles on and off, so pressing the microphone hotkey again would actually tell Dragon “wake up”.

Key points for your first dictation:

- What you dictate is transcribed at the insertion point (the blinking vertical bar) after appearing briefly in the Results Box (to anchor this box or set it to hide after a certain time, see Tools> Options> View.)

- Speaking in longer, continuous phrases provides contextual clues and thus helps Dragon choose between homophones like “right” and “write” or “to” and “two”.

- Punctuation is part of the dictation context—it has an impact on recognition accuracy.

- Two very frequent dictation commands are new paragraph (which creates a blank line) and new line.

- By default, new line does not trigger capitalization of the following word; you can change that via the Vocabulary Editor’s Properties dialog.

- Your very first dictated words may take a moment to appear on the screen. This is normal.
Dictating Special Text: Numbers, Dates, Addresses, Units...

As you saw in your first dictation, Dragon NaturallySpeaking automatically inserts spaces between words. It also follows spacing and capitalization rules: for example, it inserts a space after close quote but none after open quote, and it capitalizes at the beginning of sentences and paragraphs.

In this lesson, you learn about contextual automatic formatting that allows you to naturally dictate prices, times, dates, abbreviations, contractions, units of measure, street addresses, e-mail addresses, URLs, ISO currency codes and other special text. You also learn about Spell mode and other recognition modes.

Special Text in Normal Dictation

On the Formatting dialog (available from the Tools menu), you can turn Dragon’s rules of automatic formatting off and on, as desired.

For example, you can choose to have Dragon systematically transcribe numbers greater than two as numerals. (By default, Dragon follows the typographical rule that small integers should be written as words unless they appear in special contexts such as a unit of measure or an address.)

You can also choose to have Dragon automatically expand contractions such as “won’t” and “didn’t”.

See the Help for more details.

TIP   You can also affect what Dragon “types” via the Vocabulary Editor’s Word Properties dialog box.

Dragon can apply custom-defined contextual formatting: in the Word Properties dialog box, you can choose one or even two alternate written forms – for instance, if you prefer the word “figure” to be written as “Fig.” when before numbers (as in “Fig. 3”), or if you prefer the dictation command “new line” to trigger capitalization in addition to a blank line. Please see the lesson on Vocabulary customization.

Exercise 1: Dictate some phone numbers, with and without area code; no need to say “hyphen”.

Please call 607-585-3926 instead of 587-1239. Toll free directory: 1-800-555-1212
TIP  By default, Dragon applies its automatic formatting rules even if you pause within the segment (the option “Allow pauses in formatted phrases” lets you turn this off.) If you need to dictate sequences of 7, 10 or 11 digits and do NOT want them formatted as phone numbers, one trick is to say “numeral” just before.

**Exercise 2:** Dictate the following address. For the line containing the zip code, just say Oakland California 9 1 2 3 5; Dragon automatically uses the postal abbreviation for the state, and precedes it with a comma.

<table>
<thead>
<tr>
<th>127 Evergreen Terrace</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oakland, CA 91235</td>
</tr>
</tbody>
</table>

**Exercise 3:** Dictate the following dates. Most people naturally say “Wednesday July 16<sup>th</sup> 2009”. By default, Dragon automatically formats this as below (turning 16<sup>th</sup> to 16 and adding the commas). You can change this default to one of the many date formats offered on the Formatting dialog.

<table>
<thead>
<tr>
<th>Wednesday, July 16, 2009</th>
</tr>
</thead>
<tbody>
<tr>
<td>10/15/09 (say slash)</td>
</tr>
</tbody>
</table>

**Exercise 4:** Dictate the following sentence, or a similar one containing a price. Read the price as forty dollars and ninety cents; Dragon will automatically format it with the dollar sign and dot.

| Suggested retail price: $40.90                                                           |

**Exercise 5:** Dictate the following sentence, or a similar one containing a URL. Pronounce the URL www dot the best business dot com. Dragon will automatically remove the spaces between words.

| Please visit www.thebestbusiness.com for more information.                                |

**Exercise 6:** Dictate the following email addresses. (Remember: for e-mail addresses you frequently dictate, adding them to your vocabulary will ensure that you can dictate them very quickly and with high accuracy.)

<table>
<thead>
<tr>
<th><a href="mailto:Laura_Miller@aol.com">Laura_Miller@aol.com</a> (say “Laura underscore Miller” and “at” or “at sign”)</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="mailto:customerservice@electricalexperts.com">customerservice@electricalexperts.com</a> (say “customer service at sign electrical experts dot com”)</td>
</tr>
</tbody>
</table>

---

**The Restricted Recognition Modes**

There may be times when you wish to do a special kind of dictation, giving only commands, or only dictation, or entering many numbers or characters in a row—when inputting figures or product codes into a database, for instance. Take a moment to explore Dragon’s restricted recognition modes, which include Numbers Mode, Spell Mode, Commands Mode and Dictation Mode. (Please see the Help for details beyond the ones below.)

**TIP**  Dictation Mode can be helpful if you want to dictate *as quickly as possible*, or dictate without looking at the words Dragon transcribes.

**Numbers Mode -- Dictating Numbers Exclusively**

If you will be dictating only numbers, you can turn on Dragon’s Numbers Mode. When in this mode, the software tries to recognize everything it hears as number-related (or as a command).

**Step 1:** Say numbers mode on or choose Numbers Mode from the Words menu. (Notice the status message in the DragonBar.)
Now that Dragon is in Numbers mode, you can:
• dictate numbers and punctuation (hyphen, dollar sign...). For decimal point, say dot or point.
• say new line, new paragraph and space
• say move up|down|left|right <number> to move the focus in your document’s lines or cells.

If it hears anything else, Dragon shows “Did you say some number?” in the DragonBar message area.

Step 2: To resume regular dictation, you can say switch to normal mode, or click Words, Normal Mode.

**Spell Mode -- Dictating Letters, Digits, and Other Characters**

The Spell Mode is very useful for dictating character sequences which don’t form pronounceable words, as is often the case for part numbers, license plate numbers, codes... (It’s also useful for spelling out terms which you anticipate Dragon won’t know, such as words in a foreign language or unusual product names.)

Step 1: Say Spell Mode on or Switch to Spell Mode. The DragonBar will indicate that Spell Mode is on.
  o You can now dictate characters, including letters, digits, and symbols, as well as spacebar.
  o To capitalize a letter, say cap immediately followed by the letter.
  o As in Numbers Mode, you can use the move <direction> <number> commands to navigate, and say space. Dragon will not automatically add spaces as it usually does.
  o You cannot use new line or new paragraph, but you can say press Enter.

Step 2: You can return to normal dictating by voice (Spell Mode off...) or by hand (Words menu> Normal Mode).

**TIP** The Help topic “Spelling Characters” contains the list of possible pronunciations, including the alphabet and accented characters like “n tilde” and “alpha umlaut”. When spelling out, you can also say “oh” instead of “zero”.

**The Spell Command -- Dictating a sequence of characters**

**IMPORTANT** If you need to dictate a sequence of characters in the middle of normal dictation, the Spell command is usually faster than switching in and out of Spell mode: while in Normal Mode, you can say “Spell” immediately followed by a sequence of characters (digits, letters, symbols, and space or spacebar). See the Help for details.

This can also be useful in cases where you want to put on the screen a word that would normally be interpreted as a symbol or a command. For instance, if you wanted to be sure that Dragon types the word “comma” instead of the punctuation, you could say “Spell space C O M M A”.

Exercise 7: Dictate “access code: 75Zq/7”, then practice with similar sequences of your choice. (Pause briefly after the colon, then say “Spell 7 5 cap zee cue slash 7”. Try to not pause at all during the sequence; if you paused, just resume by saying Spell immediately followed by the rest of your sequence.)
Key points about dictating numbers and special text

✓ Dragon can format dates, times, prices, street addresses, phone numbers, Web addresses, units of measure, and other special text automatically. The Formatting dialog (from the Tools menu) lets you turn these built-in rules off or on as desired.

✓ The restricted recognition modes can make dictating special text more efficient. They are accessible by voice commands (“Numbers Mode on”, “switch to Normal Mode”) and through the DragonBar’s Words menu.

✓ If you will be dictating only numbers and punctuation, consider turning Numbers Mode on.

✓ If dictating a long sequence of characters (letters, digits, punctuation, symbols), consider Spell Mode. (The Spell command is good for short sequences which you can say all at once, without pausing.)

✓ When spelling out, you can insert a capital letter by saying cap just before the letter, and you can say space or spacebar.
Correcting Transcription Errors in Your Dictated Text

Human beings sometimes can’t recognize words correctly—especially if the speaker and the listener come from different regions, if the speaker is discussing an unfamiliar subject, or if the words are not well articulated. In addition, when we hear a word for the first time, we may not know how to spell it. Some people’s first or last names can be spelled different ways (like Gene/Jean, Hansen/Hanson). We often must verify how a person spells his or her name.

This is also true for Dragon! The software uses contextual clues and statistical information to guess what to transcribe, but sometimes cannot guess correctly. In particular, it may not recognize uncommon words on the first try, and instead types something that was likely according to its statistics. It cannot recognize and transcribe a word it has never seen.

Fortunately, in addition to optimizing acoustic factors, taking advantage of the vocabulary customization tools and using proper correction techniques will significantly reduce the number of errors. Dragon’s Help contains many details about the different ways to perform it—this workbook presents essential information for efficient correction, and introduces the Spell dialog box.

**Correcting via the Spell dialog box**

Before using the following correction method for the first time, open the Options dialog box, on the Correction tab, choose the option: "Correct" commands bring up Spell dialog box.

With this option set, you can correct misrecognitions in two simple steps:

1) Say *correct* immediately followed by the word(s) to be corrected. The Spell dialog box opens.

2) In it, indicate what you actually wanted.

As you will see, there are many ways to quickly indicate in the Spell dialog what should have been recognized—including spelling out characters, hence the name “Spell dialog.”

**IMPORTANT** *<xyz>* represents the relevant segment on the screen (which could be one or more words, and could include numbers or punctuation marks). When you give the ‘*correct* *<xyz>*’ command, be sure to say what appears on the screen, not what you had intended.

Here is an example. Let’s say you have dictated “hotel colon the Madison”, but the final word was misrecognized as “medicine”. To correct Dragon’s error, you can say *correct the medicine*. 
The Spell dialog box opens, displaying what was transcribed, as well as alternate guesses, each preceded by a number:

- **If what should have been transcribed is listed:** say choose n (the number of the correct choice: in this case, choose 3). You can also pick the correct choice by double-clicking it (or using your keyboard’s down arrow and Enter.)

- **If what should have been transcribed is NOT listed,** enter it by hand or by voice (see below), then say OK or press Enter.

The Spell box then closes and, in the text, Dragon replaces the misrecognized segment with what you indicated was the correct match for what you had dictated.

As you know, Dragon lets you use both voice and hands; at different times one may be quicker or easier than the other. In the edit line of the Spell box for instance, it can be faster to make modifications with mouse or keyboard; however you can perform correction entirely by voice.

When the Spell dialog is open, Dragon listens only for the following:

- Individual characters: letters, digits, symbols (see your documentation for details)
- Commands like backspace 5, move right 4 characters, delete previous word, select line

**TIPS** for the Spell dialog box:

- To spell a capital letter, just say cap followed by the letter.
- You can use alternate pronunciations to spell letters: “alpha”, “letter alpha”, “letter a”...
- To insert a space, say “spacebar”.
- In the Spell box, you CANNOT dictate words, but you can spell or type them.
- If no choice is quite correct but one is close, you can quickly modify it: click it once or say select and its number (for instance select 5), which brings it to the top of the Spell box, where you can edit it by hand or by voice.

**Exercise 1:** After dictating the following, use the correct <xyz> command to fix any recognition errors.

```
Until further notice, the BHDP meeting will be held in room B31 (not B40).
Special invitees this week: Stephen Hess, Anne Petersen, and Gene Wood.
```

**TIP** If several consecutive words are incorrect, correct them together. For instance, if “B40” were recognized as “before tea”, you would say correct before tea.

**Exercise 2:** Dictate uncommon words, such as nicknames or products, until a few misrecognitions appear. Use the Spell box and practice spelling out what you actually said and choosing from the list of guesses.
**Using Playback to Aid Correction**

Sometimes, especially if you dictate a significant amount of text before correcting, you may not remember exactly what you actually said. Dragon’s *playback* feature is very helpful in these instances. You can take advantage of it in several ways.

If you see that a certain word or phrase appears incorrectly, use the *correct* command to open the Spell dialog box. Once it appears, click or say *Play Back* to hear the recording of your voice as you dictated that text. If you realize that in fact you had misspoken or mumbled (as happens to everyone, particularly near the end of the day), close the Spell box, and dictate the word(s) again.

**TIP** You can have playback occur automatically with Correction. On the Correction tab of the Options dialog, check *Automatic Playback on Correction*. This is particularly helpful as you first learn to use Dragon; you may want to turn it off after a few weeks of practice.

You can also use the playback to proofread. To do this, select the text you would like to hear played back. Then, say *play that back*, or choose *Play That Back* from the *Sound* menu.

If you find a misrecognition, you can stop playback by clicking the mouse. (Since speech input cannot be received during playback, you cannot stop playback by voice. If clicking the mouse is problematic for you, play small selections at a time.)

The DragonBar’s expansion gives access to several useful items (click its arrows or say *view extras bar*):

- The *Correction button* opens the correction interface (as do the Correction commands and hot key).
- The play icons, similar to those on a music player, allow you to begin playback, speed up playback (useful for large sections of text), stop playback, and skip backwards or forward.
- The Transcribe button launches the transcription of recorded files (see the documentation for more details on transcribing from digital recorders, including the *Auto-Transcribe Folder Agent*).

To hide the extras bar, say *hide extras* or click again on the double arrow.

**Exercise 3:** Dictate a detailed paragraph—about a trip, for instance: where, how long... Then select it and play it back. If you find any misrecognitions, use the Correction button, hotkey, or commands to correct them.

**Key points about correcting recognition errors**

- Although correcting misrecognitions can seem time-consuming at first, it will result in increased accuracy, which in turn means that there will be fewer and fewer misrecognitions to address.
- To use the method described in this lesson, the option "*Correct* Commands Bring Up Spell Dialog" must be enabled.
- In Correction commands, do not pause at all between ‘*correct*’ and the misrecognized word(s).
- When the Spell box is open, you can say *choose n* to pick the correct choice from the list. If no choice is quite correct but one is close, you can quickly modify it: click it once or say *select* and its number (for instance *select 5*), which brings it to the top of the Spell box, where you can edit it by hand or by voice.
✓ If the word(s) you dictated are not in the Spell box's list of choices, you can spell them by voice or type them. You cannot re-dictate the word(s) directly in the Spell dialog - since the reason you are there is that Dragon needs a little help with this word or phrase.

✓ If the Spell dialog is open but you are not sure of what exactly was said, click or say play back.

✓ To proofread using playback, first highlight the relevant text, then say play that back or click the playback icon. To stop playback, you can click your mouse.
Deferring Correction

You know now that correcting recognition errors helps Dragon NaturallySpeaking adapt to your speech and recognize it more accurately. However, sometimes, you may not have time to correct errors before closing the document you dictated; if you dictate in DragonPad, Microsoft Word or Corel WordPerfect, the opportunity to correct misrecognition is not lost: Dragon can save what it heard in synchronization with the text you dictated, so you can later play it back and make corrections as needed.

This “Deferred Correction” feature also allows you to let someone else correct misrecognitions in your dictated documents—which means your profile gets refined without any effort on your part.

Saving Recorded Dictation

Step 1: Dictate into DragonPad, Microsoft Word or Corel WordPerfect. (If you wish to make any corrections now, do so.) When you are finished dictating, save the document as you normally would.

Step 2: Dragon asks whether you want to save the associated recording. (Your word-processor’s Auto-Save feature may even trigger this message earlier). If you or someone else will be Correcting in this document later, choose Yes.

Dragon will automatically save, in the same location as your text document, a file bearing the same name, with the extension .dra.

You may now exit the word processor and Dragon if you wish, even shut down the computer.

TIP  By default, whenever a word-processor document is saved, Dragon asks whether you want to save the recording; in the Options dialog, you can change that setting to always save, or on the contrary, never save. Recorded dictation files can get very large, so you should only save them if Correction is to take place at a later time; without the recorded dictation, you can still edit and format the document as usual.

Step 3: When you are ready to correct misrecognitions, start the application in which you dictated the document (DragonPad, Microsoft Word or Corel WordPerfect) and open the document. You can now correct recognition errors. Select some text anywhere in the document and play them back. As you can see, the audio is still associated with your text.

Once finished correcting misrecognitions in your document, you may delete the associated .dra file. (You will no longer be able to use playback on this document but you will still be able to edit and format.)

IMPORTANT  When using a .dra file, it is best to proceed in order, from the top of the document.

One of the services an experience Dragon trainer can provide is establishing optimal options and workflows, including the management of .dra files, particularly if another person will be your “Correctionist”.

Making Corrections to Someone Else’s Dictation

As you have learned, correcting misrecognitions helps ensure that your accuracy increases. However, especially at first, and depending on the quality of the dictation, Correction can be time-consuming.

The Save Recorded Dictation feature allows you to have someone else perform this important task for you. There are several ways to take advantage of it, particularly if the Roaming User feature is used—details are available in the online Help and IT Administrator’s Guide.

The following is an example of third-party correction: Jane has tasked her assistant, Bob, with performing Correction on her dictated documents, using his own computer.
**IMPORTANT:** The dictator’s profile must be accessible from both computers. Copying profiles onto another computer is easy, but if the profiles are in a Roaming configuration, it is not necessary: their Master copy resides on the network, making them usable from any connected computer.

**Step 1:** Jane dictates her reports. When she is finished, she saves the documents to a network location Bob can access from his computer. When Dragon asks whether she wants to save the audio, she chooses Yes. If she wishes, she can now exit Dragon and/or her word processor, and shut down her computer.

**Step 2:** On his own computer, Bob starts Dragon; when prompted to open a User profile, he chooses Jane's.

**Step 3:** Bob starts the word processor Jane used, and opens the first report. He is now ready to perform Correction in this document.

**Step 4:** Starting from the top, Bob looks for “abnormal” text and highlights it manually. On the expanded DragonBar, he clicks the Playback icon (Bob should NOT use his voice here.)

**Step 5:** Watching the screen, Bob listens and as soon as he hears an error, he clicks the Correction button or presses the Correction hot key, which brings up the Spell dialog.

*If not quite sure of what Jane actually said,* he clicks Play Back to hear her recorded voice. If the input is not “clean” (people sometimes make unintended sounds, stumble on a word…), he clicks Cancel and deletes the mis-spoken segment in the document before typing what was intended.

*If the correct alternate appears in the choice list,* he clicks it with his mouse then clicks OK.

*If the correct choice does not appear in the list,* he types it in, then clicks OK or presses Enter.

When he has finished checking the document (and made any cosmetic modifications as warranted), Bob saves it. Now not only is the document finalized, but Jane’s profile has been refined through the corrections performed, which will help the accuracy of her future dictation.

The following is only necessary if Roaming is not used: Bob exports Jane's profile to the network (through the Manage Users dialog); from there, Jane can import her newly-refined profile.

**Key points about deferred correction**

- When you dictate in Word, WordPerfect or DragonPad, Dragon can save the recording associated with your text so misrecognitions can be corrected later, as if you had just dictated it.
- If you choose to save your recorded dictation, you can use Correction and Playback features later: simply start the word-processor in which you dictated the document, then open the document.
- You can postpone Correction, or delegate it to a third party—your assistant, for instance.
- When saving your document’s recording, Dragon creates a file in the same directory as your text document; both files have the same name, but the synchronized recording has the extension .dra.
- Dictation files can get very large, so only save them if necessary. Also, when you are finished making corrections to a document, you may wish to delete the associated .dra file; you will still be able to edit the document normally, and you will save disk space.
- The “Correctionist” must open the speaker’s profile but not speak into it. One can bring up the Correction interface by clicking the DragonBar’s Correction button or pressing the Correction hotkey (by default, the minus key on the numeric keypad).
- To be used for Correction, the .dra file must be in the same folder as the document itself.
Editing Text by Voice

Dragon NaturallySpeaking lets you use your voice to move around within a document and edit the contents—whether or not that document was originally created by voice. As you learned, the software transcribes your dictation wherever the insertion point is (usually shown as a thin blinking vertical bar some call cursor.).

Here are some of the commands to select text and move the insertion point. Mouse and keyboard can still be used, of course. Don’t try to do everything by voice unless you have to; at first, focus on dictation accuracy — speaking clearly, adapting the vocabulary, performing corrections...

Navigation and Selection Commands

TIP Navigation commands use the words go and move interchangeably, and a space counts as one character.

- Some commands move the insertion point regardless of its starting location:
  - move to top, or go to start of document -- moves to the beginning of the document
  - move to bottom -- moves to the end of the document

- Other commands move the insertion point relative to its present location:
  - move to end of line (the current line, the one containing the insertion point)
  - move up(down) 1-20 line(s) or paragraph(s) -- e.g. move up 3 lines
  - move left(back) 1-20 word(s) or character(s) -- e.g. move left 7 words
  - move right(forward) 1-20 word(s) or character(s) -- e.g. move forward 3 characters

- The insert commands position the insertion point just before or just after a specific word or punctuation mark:
  - insert before your office -- moves the insertion point to just before the phrase "your office"
  - insert after Joe comma -- moves to just after the comma following the word “Joe”

The select commands let you “highlight” editable text visible on the screen. Below are just some of them.

- You can say select followed by what you wish to highlight (include punctuation as needed):
  - select next 2 words
  - select let me know
  - select comma obviously comma

TIP For words (or phrases) that appear several times in your document, you can use the command select again to move the highlighting until the desired instance is selected. Also, for commands that quote from the screen, it can be useful to name more than just one word, to avoid possible ambiguity: e.g. to correct “a” in “received a request,” you may want to say “correct received a” or “correct a request.”

- Very useful for longer phrases: you can specify a range by naming its beginning and end:
  - select do let THROUGH convenience - “do let me know please at your earliest convenience”

- You can select one or more lines or paragraphs at a time: select line, select previous 3 paragraphs...

- You can select around the insertion point: select previous 5 words, select next character...
• You can select the entire content: select all
• You can “unselect” a selection by saying unselect that or deselect that. (Another way is to move the insertion point with a move right command, for instance.)

TIP  As with all commands, you must say these as a continuous phrase, with a brief pause before and after. For commands that quote words from your screen, choose your target words before you start to say the command. Otherwise, any hesitation will cause the words of the command to be typed on the screen. (If this happens, just say scratch that and try again, without pausing this time.)

One should always strive to dictate in complete phrases, since context helps the recognition of text. When it comes to commands, formulating the whole phrase and dictating it without pauses isn’t just helpful, it’s essential. The exercises below will provide plenty of practice.

Direct Editing: Bold | Underline | Italicize | Capitalize | Copy | Delete | Cut

Dragon lets you perform frequent editing tasks quickly: like you can quote from editable text in the commands select <xyz> and select <start> thru <end>, you can say the verbs bold, underline, italicize as well as capitalize, immediately followed by the desired word(s). This “Quick Voice Formatting” also applies to copy, as well as delete and cut—these three can be disabled under Options.

IMPORTANT: If these commands are enabled, Dragon will try to recognize as one of them any phrase starting with one of these verbs followed by a word (or words) present in the text: e.g. “bold measures” or “cut corners.” Since Dragon recognizes commands only if they are spoken as one flow between two pauses, this won’t happen if the phrase is within a sentence or if you pause within the phrase, but it could happen if the phrase is said in isolation—for instance, if the speaker is creating a list, or had just hesitated as one often does when composing out loud. (If this does happen, you can say undo that.)

Remember in particular the possibility of unintended recognition of cut <xyz> and delete <xyz>, especially if you dictate without looking at the screen; if you prefer to avoid this risk, disable them by clearing their checkbox on the Commands tab of the Options dialog.
**Select-and-Say™, non-standard windows, and the Dictation Box**

Commands such as ‘correct <xyz>’ and ‘insert after <xyz>’, which quote from the active text field work thanks to a Dragon functionality called Select-and-Say. This functionality requires the text field to let Dragon be aware of its content—such as where words (and sentences) begin and end, so that Dragon can automatically apply spacing between words, and capitalization at the beginning of sentences...

Many popular applications build most (if not all) of their text fields in a standard way, and as a result Dragon is always aware of the text content. However, you may sometimes encounter a text field from which Dragon cannot constantly get information—and therefore cannot always apply its normal capabilities. You may not notice anything if you just dictate, but if you take actions like correcting or inserting text within a sentence, Dragon may not be able to execute its <xyz> commands and to apply spacing as it usually does.

When the insertion point is in such an area, the DragonBar displays the message “Dictating in a non-standard window” and its Select-and-Say indicator (a large bright green dot on the DragonBar next to the NaturallySpeaking menu) will turn grey.

Even in “non-standard windows”, one can use Dragon efficiently, knowing the following:

1. Many users, if dictating short entries, just apply what does work everywhere: they dictate normally, and, if necessary, say ‘spacebar’ or press the spacebar, say ‘Cap’ to force capitalization, say ‘move <left|right|up|down>’ commands or reposition the insertion point by hand, etc.

2. You can use Dragon’s **Dictation Box**, an intermediary in which you can create, modify, and correct text as usual; you can even use boilerplate custom commands to paste text.

   When the text is ready, just say or click the **Transfer** button: Dragon closes the Dictation Box and transfers your text to where you had the insertion point.

   To open the Dictation Box, you can:
   - Say a command such as ‘Open Dictation Box’
   - Use the DragonBar’s Tools menu
   - Use its hot key: Ctrl+Shift+d

   There is a lot of flexibility around the Dictation Box. In addition to changing its hot key in the Options dialog, you can:
   - Give its command one or more alternate names (from the **Command Browser**: to find the command, you can filter for the word box in the Context “Global Commands.”)
   - Modify its appearance and behavior, via its **Settings** button: default font size, positioning (anchored, or near the cursor), whether it shows how many characters it contains...
TIP: You can have different Dictation Box settings for different applications. Also, you can have multiple Dictation Boxes open at one time.

The Help contains more details about the Dictation Box.

**Replacing and Inserting Words**

The *select* commands are very useful when you wish to change some of the text on your screen. As you would with mouse or keyboard, you select the relevant segment, then you overwrite it—by dictating or typing.

For instance, if your text reads "100 Main Street" but you wish to change it to "500 Washington Street", say select 100 Main (pause) 500 Washington.

**TIP** For larger passages, take advantage of select line, select <start> through <end>, select paragraph...

**Exercise 1:** Practice “overwriting” by voice. Observe then dictate the following paragraph.

```
I will be in Boston for a few days next week, and would love to get together for lunch. We could meet at your office at noon. I’ll be staying at the Madison downtown; give me a call. Talk to you soon!
```

1) Say select lunch.  ➔ You should see the word “lunch” highlighted.
    Say an early dinner.  ➔ The sentence should now read “get together for an early dinner.”

2) Say select noon.  ➔ You should now see the word “noon” highlighted.
Say six o’clock. → The sentence should now read “We could meet at your office at 6:00.”

3) Say select in through week. → The words “in Boston for a few days next week” are highlighted.

Say in your area on Tuesday. → The sentence should now read “I will be in your area on Tuesday...”

Let’s say we now want to add a few words inside this paragraph.

4) Observe the insertion point’s current position. Say insert after dinner, then say if you have time.

5) Say insert before exclamation mark (observe the move), then say comma I hope.

TIP If, after doing some editing in your text, you need to remove trailing white space, you can use commands such as backspace or delete next character for a single space. A good trick is saying backspace combined with a number: backspace 5 is like pressing the backspace key 5 times.

Dragon’s many selection and navigation commands can help you quickly edit text—whether or not this text was created by voice.

Here is another exercise. Perform it entirely by voice, but remember that for optimal productivity in daily work, you can use a combination of voice and keyboard/mouse.

Exercise 2: Look at the following text, dictate it, then edit it as described below.

Dear Ms. Cooper,

It was nice meeting you Tuesday. I think you have some good ideas about the Johnson project! Let’s get the team focused on this project by February. When you have time, could you write up your comments and email them to me? I would really appreciate it.

• Edit the first sentence so it reads “meeting with you last Tuesday”.
• Edit the second sentence so it reads “You have some great ideas”.
• Edit the third sentence so it reads “on this important project”.
• Edit the third sentence so it reads “by early February”, and insert a blank line after it.
• Change the fourth sentence to “Could you please write up your notes and email them to me ASAP?”
• Edit the salutation, changing “Ms. Cooper” to “Allison”.
• Edit the last sentence, removing “really”, and add a closing line of “Sincerely, Susan Martinez”.

Which commands did you find most useful in each situation?

**Key points about editing text by voice**

- You can use Dragon to edit a document by voice whether that document was originally dictated or typed.
- The editing commands can address small or large amounts of text, even several paragraphs or the entire document (select all).
At first, uttering the whole command can be tricky for commands that quote words from your text, such as select... through... and insert before.... As usual, deciding what you are going to say before starting to speak is recommended. If you paused mid-command, just say scratch that, pause, and give the complete command again.

If the word or phrase you want to select appears in several places, you can use select <xyz>, followed by the command select again to move to the next instance.

The commands that quote your text (select <xyz>, bold <xyz>, correct <xyz>, insert after <xyz>...) work thanks to a functionality called Select-and-Say™, which depends on Dragon’s ability to constantly obtain information from the text field—for instance, in order to know where words and sentences begin and end, so Dragon can apply spacing between words and capitalization at the beginning of a sentence...

If the text area in which you are dictating is “non-standard”, remember that if needed you can say Cap to start a sentence and spacebar to create a space, as well as use the Dictation Box—a text window that has full “Select-and-Say” functionality: when you are finished, the content is transferred to your original location. (See the Help for more details.)

You can modify the Dictation Box’s appearance and behavior from its Settings button; in addition, you can modify its hot key in the Options dialog and give its command one or more alternate names.

You can set the Dictation Box to behave differently depending on the application from which you opened it.
Formatting Text by Voice

Whether text was originally dictated or typed, Dragon NaturallySpeaking lets you use your voice to control font (Arial, Courier...), font style (bold, underline...), font size, alignment (center, right-align...), color, and more.

The "X that" Convention

Dragon has many commands to tell the computer to perform a certain action on a certain item. Many are phrased as "X that", with X being a verb for the desired action: for instance, italicize that and delete that. (Remember, for commands to be recognized, you must pause before and after but not in the middle.)

When Dragon hears an "X that" command, it decides what “that” is as follows:

1) If anything on the screen is highlighted (whether by voice or by hand), Dragon performs the action on that selection. (It can be one or more characters or words.)

2) If nothing is highlighted, Dragon performs the action on whatever you dictated since you last paused—in other words, the contents of the Results box, the “last utterance”.

Note: In Dragon’s commands, you can say “the selection” instead of “that”.

Dragon’s "X that" formatting commands include:

- **Cap that** - capitalizes the first letter of each word in the segment (e.g. Water Management)
- **ALL CAPS that** - capitalizes all the letters of each word in the segment (e.g. EXTREMELY IMPORTANT)
- **no caps that** - puts in lowercase all the letters of each word in the segment (e.g. american express)
- **delete that** (Dragon Version 10 also lets you do this as “delete <xyz>”)
- **scratch that**
- **bold that, italicize that, underline that** (Version 10 also lets you do this as “<verb> <xyz>”)
- **restore that** - removes all bold/italics/underline formatting from the segment
- **left-align that, right-align that, center that, justify that**
- **copy that** (Version 10 also lets you do this as “copy <xyz>”)
- **cut that** (Version 10 also offers “cut <xyz>”)
- **paste that**
- **hyphenate that** - puts hyphens in the spaces within the segment
- **compound that** - removes spaces between words in the segment
- **bullet that** (make sure you are familiar with how your particular application handles bullet points)

**TIP** You can repeat delete that or scratch that to delete the last utterances you said. You can also say scratch that 3 times, scratch that 8 times, etc.
The "Format That" Commands

Not all formatting commands are worded as “X that”, but all follow the same rules about what text the action is performed on: the selection if there is one, otherwise the last utterance (what was said since the last pause.)

The many “format that” commands include:

format that bullet style -- bullets the designated text (you can also say bullet that)
format that strikeout -- places a line through the selection (for example, January 19)
format that centered

Note that command combine several indications, such as:
format that Garamond, format that Arial 12, etc. -- gives the selection the font name/size specified
format that 20 point, format that 12 point, etc. -- gives the selection to the point-size specified
format that bold italics
format that Caps bold
format that regular

Exercise: Dictate the following to experiment with giving format commands as you dictate and afterwards.

I finally read The Grapes of Wrath. It was TERRIFIC! Although it is long, I read it surprisingly quickly.

TIP To undo the last action, say undo that. This is equivalent to Undo in the Edit menu, or {Ctrl Z}.

Key points about formatting documents

✓ The “X that” commands apply to the current selection, or if there is none, to the last utterance (what was dictated since the speaker last paused.)
✓ As with all Dragon commands, you must pause briefly before and after saying these formatting commands.
✓ You can repeat delete that or scratch that up to 10 times to delete the last things you said—you can also say scratch that 3 times, scratch that 7 times...
✓ To undo the last action, you can say undo that.
Controlling the Operating System and Applications

Dragon NaturallySpeaking can do much more than type and format your dictated text: it lets you start programs, open desktop items, switch between open windows, maximize or minimize windows, choose menu and submenu items, navigate dialog boxes, “voice-click” buttons, “voice-press” keys, move the mouse pointer, and much more, without touching the mouse or keyboard.

Of course, when Dragon is running, you can still use your mouse and keyboard. Mouse, keyboard, and voice are just three input options. Use whatever is fastest and easiest for a given task.

Let’s start with a very frequent task made fast and easy thanks to Version 10: searching your computer.

**Keyword-searching the Computer**

Available in editions ‘Preferred’ and up, Dragon 10’s “Voice Shortcuts for Desktop Search” help speed up a process many of us go through very often: finding information that we know is somewhere on our computer!

At anytime, no matter what application is currently active on your screen, these commands let you launch the search for items containing the keyword(s) you specify. They use indexing software including Google Desktop (freely downloadable from Google’s website).

These search commands have flexible wordings (the Command Browser lets you see all the possible ways to say them). They can be general (“search computer for <xyz>” -- <xyz> being any word or words), or specific:

- **Search email for <xyz>:** searches for the keyword(s) in just the e-mails indexed on your computer
- **Search [the] documents for <xyz>:** searches just the indexed files
- **Search [the] history for <xyz>:** searches just the indexed Web pages visited

**Note:**

These “Desktop search” commands can be disabled or enabled on the Commands tab of Dragon’s Options dialog box.
Opening and Closing Programs and Windows

To close the active window, you can say click close.

To start a program by voice, say start (or open) immediately followed by the name of the application. For instance, start DragonPad, start Internet Explorer, start Notepad or start Lotus Notes.

TIP Do you need to say "start Word", "start Microsoft Word" or "start Microsoft Office Word 2007"? In the Start Menu (on your Windows taskbar), look in Programs. Some programs require clicking a series of submenus. Whatever the final submenu is called is the name Dragon may expect. If you find the listed name inconvenient, you can create a shortcut to the application and rename that shortcut to something easy; once you have done that, you can also use the easier name to open the application.

Similarly, you can open any item you see on your desktop (including files and folders): just say open followed by its name. For instance, to open an item called “winter projects”, you could say open winter projects. (Here too, it’s helpful to have easily recognizable names!)

To open the Windows Start menu, say click Start or click Start menu (this and other menus can be navigated by voice, as you will see).

Resizing Windows and Switching Between Them

To minimize an active window, say click minimize or minimize window (the window remains on your screen, minimized as a taskbar icon). To maximize (enlarge to fit the screen) an active window, say click maximize.

If several windows are open on your computer, you can change which one is active and in the foreground:

- Say switch to followed immediately by the name of the desired application, folder, or document: e.g., switch to DragonPad, switch to Lotus Notes, switch to My Computer, switch to DragonBar, switch to winter projects.

- Say switch to previous window to go back to the previously active window.

- Say switch to next window as many times as necessary to cycle through all the open windows (this is equivalent to pressing Alt +Tab).

“Clicking” Menus, Submenus, and Dialog Box Controls

To “click” on an application menu or submenu, just say its name; for instance, for a menu labeled Insert, say Insert. (The application must have the focus, which you can usually tell by the appearance of its title bar.)

When accessing a submenu, pause briefly after the name of the menu. For instance, to see the available toolbars in applications like Word 2003, you can say View (pause) Toolbars, and to save a file under a certain name, you can say File (pause) Save As.

To close an open menu, you can just say cancel or press Escape (just like pressing the Esc key at the top left of your keyboard.)

Note for Office 2007 users: to click the Office Button (equivalent to the File menu of earlier Office versions), say "Office Button". To use Office 2007, familiarize yourself with the menu “Ribbon” and its ScreenTips (revealing the item’s name), Quick Access Toolbar, and KeyTips (the new display of keyboard shortcuts).
By default, some Microsoft applications show only the most-used menu items. For optimal voice usage, consider changing this default: in the application’s Tools menu, open the Customize dialog, and check the box “Always show full menus.”

Menu items often open dialog boxes, which may contain controls such as buttons, checkboxes, tabs, and radio buttons. How do you access these by voice? You guessed it: “say what you see”!

**IMPORTANT:**

You can choose to have Dragon require the word ‘click’ just before the name of the item: for a button labeled “Next”, you would say click next. Dragon offers a similar “Require ‘Click’” option for HTML links. (See the Commands tab of Dragon’s Options dialog.)

This workbook presents several of Dragon’s dialog boxes, which often contain controls labeled Cancel, Next, Yes, No, or OK; as you follow the step-by-step instructions and perform the exercises in each chapter, take the opportunity to practice accessing the boxes and their controls by voice.

Exercise 1: Previous lessons introduced you to the Options dialog box; we will use this dialog box to practice accessing buttons, tabs, and other interface controls.

1. Open Dragon’s Options dialog, then its View tab.
2. Select and unselect the radio buttons and checkboxes for the DragonBar.
3. Restore the defaults.

**“Natural Language Commands” and the Command Browser**

Dragon comes with large sets of commands that let you order actions directly, and in a natural manner, instead of going through menus, submenus, and dialog boxes: for instance, saying “Insert Page Break” in Microsoft Word instead of opening the “Insert” menu, then choosing the submenu “Break”, then the option “Page Break”.

Dragon’s “What Can I Say” window contains a sampling of these commands (depending on what application is currently active, and what edition of Dragon you have.) As you will notice, Dragon’s command names tend to describe the action, starting with the verb, then the object; since Dragon has so many commands, with many possible wordings, you can try saying what you want to do, and if you get unexpected results, say “Undo That”.

- To read about the commands for a specific application, open the Help (you can say Show Help topics) and enter that application’s name in the Search field.
- To see all the commands and their variations (optional words, alternate words, etc.), open the Command Browser and search via its Context list and Filter box, to have the Command Browser display just the commands that contain a particular word or words. If you see a command that looks interesting, make sure it’s highlighted in the list, then use the links on the Command Browser’s menu, such as Refine or Undo All, to expose its full wordings (for instance, to include all optional words or expand ellipses.)

**IMPORTANT:**

If it detected that your computer’s resources would not allow it to perform with both speed and accuracy, Dragon may have disabled its Natural Language Command sets for Word, Excel, PowerPoint, and WordPerfect. If speed is not a priority for you, and you wish to use Natural Language Commands in one or all of these applications, you can enable them via the Option dialog’s Commands tab. (See the Natural Language Commands button near the bottom.)
Note: If you enable the Microsoft Word set, for instance, Dragon’s speed within Word (or Outlook using Word as its editor) may decrease.

“Voice-Pressing” Keys

At times, you may wish to press a key or two on your keyboard; you can use Dragon to “voice-press” them.

TIP  Common accelerator keys for Windows operating systems include: Esc to close a window, Enter to activate the item which has the focus, Tab to move the focus forward, and Shift+Tab to move the focus backward. (You can search your application’s Help for specific ones; many websites also list useful hot keys). Most buttons, menus and checkboxes have an underlined letter in their label: you can activate them by pressing the underlined letter (if underlines are not visible, press Alt first.)

Dragon lets you “voice-type” any key on your keyboard. Just say press or type followed by the name of the key(s): any letter or number, but also Page Up, Home, Enter, Tab, Caps Lock, F2, Control, Alt, Shift...

For instance:

Say press spacebar to select or unselect a checkbox.
Say press F5 or press Function 5 to refresh the view.
Say press Alt e to “click” a button labeled with an underlined ‘e’.
Say press Control f to open the Find dialog box in most applications.
Say press Escape to “escape” out of a window.
Say press Alt Down to open a drop-down list.

To undo a keystroke, you can say undo that.

Exercise 2: Observe this Find and Replace dialog box and its controls: tabs, drop-down list, and buttons. Answer the following questions about it (think of “voice-typing” as well as “voice-clicking” options). Then open the Find dialog in your word processor and practice navigating it by voice.
**Find and Replace**

- How could you place the insertion point in the Find field? How could you go to the other tabs?
- Which control currently has the focus? How could you move the focus to the Find Next button? How could you close this dialog box?

---

**Key points about controlling your computer by voice**

- You can open an application (or desktop item) by saying **start** or **open** immediately followed by the name of the application (or item). You may want to provide easy names for these items.
- You can switch between windows with commands like **switch to DragonPad**, **switch to next window**.
- To click menus, buttons, and other controls, you can “**say what you see**” (you can choose to say “click” right before, or not.)
- You can “voice-press” any key by saying **press** or **type** followed by the name of the key.
- Dragon 10 offers commands to search your computer for items containing the keyword(s) you specify (these commands take advantage of the indexing done by software like Google Desktop, which must be running on your computer). For instance, to find all indexed e-mails containing the words “Canada” and “budget”, you can say **search email for Canada budget**.
Using Dragon NaturallySpeaking with the Internet

Below are some commands for common Internet-related tasks. The Command Browser lists many more, and the Help contains a lot of detail about using your voice on the Web and about Web-related Dragon options.

TIP In editions “Preferred” and above, Version 10 added commands you can say anytime to perform general Web searches, Web searches in specific categories (maps, news, products, images, videos) or searches in certain specific sites, like Wikipedia. You could say for instance ‘search images for chrysanthemum’ to see images found for that word by your default search engine.

You can even take advantage of capabilities of specific engines: one example is Google’s conversions and calculations, as in ‘search Google for 53 percent of 1100’ and ‘search Google for 77 euros in dollars’.

A key advantage of these “Web search shortcuts” is that, like the “desktop search shortcuts”, they can be used anytime, no matter what program is currently active on your screen; they are very convenient time-savers!

Note: After giving one of these search commands, you may not see any change on your screen right away; this is normal since the search itself needs a moment to complete.

The following commands cover actions often done in HTML pages and work with supported Web browsers (there are dozens of commands for Mozilla Firefox and Microsoft Internet Explorer; please see the Help.)

Say **go to address** to go to the address bar; after entering a URL, say **go there** or **press Enter**.

Say **go back** or **go forward** to click the Back or Forward buttons; say **go home** to access the homepage.

Say **add to favorites** to add the current site to the Favorites list.

Say **refresh page** or **reload page**. (To stop a page load, you can say **stop loading**.)

Say **page down** or **start scrolling down** to see more of the web page. (You can then say **stop scrolling**.)

To click a **hyperlink**, you can say its name or just part of it, preceded by the word ‘click’ or not. (If a red arrow appears next to it, say **click that**.)

**IMPORTANT:** Dragon is always looking to match what it hears to possible commands. For HTML windows, you can choose to require ‘click’ before the link name, since if you dictate a word or phrase in isolation, it may activate a link instead of being transcribed—see the Commands tab of Dragon’s Options dialog.

If what you said matches multiple items on the screen, Dragon will display **numbered arrows** next to the items; to indicate the desired item, say **choose 3** or whatever number corresponds to your choice. (If you need the numbers to go away, just say **hide numbers**.)

Say **text field** or **edit box** to move the insertion point to the first text field on the screen. If you want to dictate into another text field, you can say **next control**.

Say **click image** to click on an image (on the Web, some items may be designed to look like text buttons, but are actually images.)

Say **click check box** to select (or unselect) a check box.

Say **click radio button** to select a radio button (round option button).

Say **click list box** to select a list box, and **drop list** to display the list (to highlight list items, you can use the **move up n** and **move down n** commands)

Say **click close** or **press Escape** to close a popup window.

Note: These commands require the setting “Enable commands in HTML windows,” which is on by default and can be found on the Command tab of the Options dialog.
Using Dragon NaturallySpeaking for E-mail

Dictating is in itself a great benefit of Dragon NaturallySpeaking for e-mail usage. For certain e-mail applications, you can use Dragon beyond just dictation: below are common e-mail commands.

For Microsoft Outlook, for instance, there are hundreds of commands for the Inbox (you can flag messages, for instance), the Tasks, the Calendar... Dragon 10 even offers commands to directly create Outlook messages and calendar entries, naming the recipient(s), *no matter what is currently active on your screen*: at any time, you can say, for instance, “create email to Jane Miller and Payroll”, or “schedule meeting with Joe Keller”.

**TIP** As seen earlier, users of Lotus Notes, Outlook, Outlook Express and Windows Mail can take advantage of Dragon’s ‘Increase Accuracy From E-mail’ tool to automatically adapt its Vocabulary and identify names of Contacts. Also, although Dragon can automatically format email addresses and URLs, consider adding to the Vocabulary the e-mail addresses and domains you use frequently (do specify Spoken Forms as needed.)

You can start your default e-mail program by saying **Start mail**. With the e-mail program open, you can say:

- **new mail** - creates a new mail message
- **open mail** - opens the mail message highlighted in the list
- **close mail** - closes the open mail message
- **forward mail / this** - forwards the highlighted or open mail message
- **reply to mail / this** - replies to the highlighted or open mail message
- **delete mail** - deletes the highlighted or open mail message
- **check for new mail** - checks for new mail/opens your Inbox

In e-mail commands, you can substitute **message**, **e-mail**, or **memo** for **mail**.

**TIP** In lists (of messages, of folders...), you can use navigation commands like **move down 3**, **move up 9**...

As you create e-mails, you can move between fields by hand, by saying **Tab** or **Tab key**, or by saying (the word **field** is optional, and you can substitute **go** for **move**):

- **move to To [field]** - moves the cursor so that you can then dictate the recipient’s address
- **move to CC [field]** / **move to BCC [field]** / **move to Subject [field]**
- **move to Body [field]** - moves the cursor to the body of the e-mail so that you can dictate the message

**Key points about Dragon 10 and e-mail**

- In supported e-mail programs, Dragon provides, in addition to dictation support, many voice commands to perform tasks, such as **open message**, **delete memo**, **go to Subject**...
- In e-mail commands, you can use the words **message**, **e-mail**, **memo**, or **mail** interchangeably.
- If you have Microsoft Outlook, you can use Dragon 10’s direct commands like **book meeting with** <contact(s)>, **create message to** <contact(s)>, **create email about** <subject>, to quickly generate new messages or appointments, *no matter what application is active*.
- You can see more e-mail commands in the Sample Commands window and the **Command Browser**; in addition, the Help contains many details about using Dragon with e-mail.
Dragon NaturallySpeaking and Microsoft Word

In “Controlling the Operating System and Applications”, you learned about Natural Language Commands. Since Microsoft Word is an application many people use, this chapter lists built-in commands for this word processor.

Corel WordPerfect has similar commands, so it shares the same Sample Commands window. If the application’s Natural Language Command set is disabled, the Sample Commands window will show Global Commands. Remember that if your system resources are low, enabling these commands could decrease Dragon's speed.

This chapter also covers a few special points of interest regarding Word: ctfmon (on Windows XP only) and Voice Notations.

Special note for Windows XP: turning off CTFMON

After installing Dragon on a Windows XP system, errors may start appearing when using Microsoft Word if the Microsoft Alternate User Input application (CTFMON.EXE) is also installed and running.

You can disable CTFMON.exe via a simple checkbox during Dragon’s installation, or later from the Miscellaneous tab of the Administrative Settings dialog box. The Administrative Settings box is accessed via the DragonBar’s Tools menu, when no user profile is open (if necessary, choose Close User from the NaturallySpeaking menu.)

“Voice Notations” in Word documents (editions “Professional” and up)

The higher editions of Dragon let you add “Voice Notations” in Word: text that can later be used with Word's Accept/Reject Change functionality. A Notation could be anything you do not want permanently in your document or you do not want transcribed, e.g. instructions you speak for the benefit of your assistant. Voice Notations are not used by the Acoustic and Language Model Optimizer.

To add a Voice Notation, press the Esc key while dictating. Voice Notations are highlighted in green and formatted as red, italic text.

Commands for Word 2003 and 2007

For applications like Word, Dragon has so many commands (and many different wordings for most commands), that we couldn’t possibly list them all here (and in the Sample Commands window!).

If you are working in a supported application and you encounter an action you’d like to perform by voice, open the Command Browser and use its Context list -- and its Filter box, to see a modular display of just the commands that contain a particular word or words. If you see a command that looks interesting, make sure it’s highlighted in the list, then use the links on the Command Browser’s menu, such as Refine or Undo All, to expose its full wordings (for instance, to include all optional words or expand ellipses.)

TIP: If you say what you think is a command, but Dragon takes no action, or just transcribes the words on the screen, look in the Results box. If the box does not have a thick border, Dragon did not recognize what you said as a valid command for the current situation: if you say “Insert a 2 by 2 Table” when the insertion point is inside a table, nothing happens because you cannot insert a table inside a table.
Here is an example of a Help topic, listing commands for working in Word documents.

### Basic document commands in Microsoft Word

You can use the following voice commands to perform basic document operations using Microsoft Word (click the operation you wish more information about):

- **Creating, opening, and closing a document**
- **Saving a document**
- **Page Setup**
- **Viewing the document**
- **Printing**
- **Checking spelling and grammar**
- **Searching and replacing**
- **Inserting document segments**

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
</table>
| Add a page        | 1. "Go To <location>" (to move the insertion point to where you want to insert the new page). For example, "Go To Bottom" to add a new page at the end of the current document.  
|                   | 2. "Add a New Page"                                                 |

Many of Dragon’s commands work for both Word 2003 and Word 2007, such as:

- **New** file
- **Save** the file. Save file as.
- Create a 3 by 7 **table**
- Add **page numbers** [at bottom left|center|right]
- **Delete next** sentence
- **Find** a word. Find and **replace**.
- Set **page orientation** to Landscape
- **Print** pages 3 to 7. Print the selection. Print [this] page
- View page **layout**. **Change view** to print layout.
- **Zoom** to 50 percent. Zoom to **full** page. Change zoom to **page width**
- Set **page width** to 8 inches
- Show|Hide **paragraph marks**
- **Double-space** the document. **Single-space** this paragraph
- Set the font color to green in this line
- Set **background** to yellow
- Show **word count**
In addition to letting you navigate by voice the “Ribbon Interface” introduced in Office 2007, Dragon 10 contains commands for Word features introduced by that version; below are just a few.

**Common Tasks:**
- Go to/Switch to/Hide/Open/Display thumbnails
- Turn side by side view off/on
- Add/create/insert [a] special character
- Add/create/insert [a] hyperlink/chart

**Page Layout menu**
- Create/add/insert a watermark
- Set the page color
- For themes:
  - View themes
  - Set colors of theme
  - Change the font of [that/the/this] theme
- For line numbering:
  - Create/add line numbering continuously
  - Delete/remove line numbering

**Reference menu**
- Previous footnote/endnote
- Create/add/insert [a] citation/caption
- Create/add/insert index
- Add [this/it/that] in the index

**Review menu**
- Show/view/open/hide/close [the] research pane
- Translate the first sentence/word. Translate the entire page
- For comments:
  - Create/insert/add [a] new comment
  - Erase/delete/clear all comments shown
  - Go to next/previous comment
- Hide/close [the] review pane
- Accept/reject change and go to next

**Office Button menu**
- Open/show document information [panel]
- Quick print [file/document]
- Save [document] as PDF
- Encrypt file
- Add digital signature
- Mark [the] file/document as final
- View/open/show [the] document management pane
- Share [the/that/this] document/file

**Blog Post menu**
- Create a new blog account
- Open a blog post
- Publish [this/that] post to [the] blog account

**Mailings menu**
- Create blank/new envelope/label
- How/view/hide merge preview
Dictating and editing in Microsoft Excel

You can use Dragon to dictate and edit content into Microsoft Excel spreadsheets. Many Excel-specific commands are built into the higher editions; the What Can I Say window shows some, and the Command Browser lets you discover the full set. In addition, the Help describes commands usable in Excel to fill or hide rows or columns, sort, sum or average values, widen columns, and more (see Help example below.)

Remember that the Natural Language Commands for Excel may be disabled or enabled from the Options dialog.

In this lesson, sample steps guide you to practice tasks such as entering text, moving between cells, editing existing cells, and correcting recognition errors inside cells.

<table>
<thead>
<tr>
<th>To</th>
<th>Say</th>
</tr>
</thead>
</table>
| Sum or average a column or row of numbers | 1. Move the insertion point to the cell where you want the sum to appear  
                                           2. "Sum/Average the Values on the Right/on the Left/Above/Below" |
| Sort a column or row of numbers     | 1. Select the row, column, or range of cells you want to sort  
                                           2. "Sort the Selection"                                                  |
| Change contents from decimals to fractions | 1. Move the insertion point to the row, column, or cell you want to change  
                                           2. "Set This Row/Column/Cell to Fractions in <number>"; for example "Set this Cell to Fractions in Eighths" |
| Lock or unlock contents             | 1. Move the insertion point to the row, column, or cell you want to lock or unlock  
                                           2. "Lock/Unlock This Row/Column/Cell"                                    |
| Fill a cell, row, or column         | 1. Move the insertion point to the row, column, or cell you want to fill with content |

**IMPORTANT:** If you want to mention a cell in a command (such as “move to cell D5”, or “select cell B3 through cell H3”), be sure to say the word “cell”. Note: you can use alpha bravo Charlie etc. instead of A B C.

There are two editing modes in Excel: Quick and Full. Make sure you are familiar with how your version of Excel functions, especially for editing content in cells; notice when the Status Bar (bottom left corner) indicates “Edit” and when it indicates “Enter” -- as well as when the mouse pointer changes.

- **Quick Edit:** To enter new content into a cell, overwrite the current content of a cell, or format the entire content of a cell. When you select a cell and begin dictating, a yellow background appears; if the cell currently contains text, the dictated text will overwrite it.

- **Full Edit:** To edit the existing contents of a cell. Select the cell and say “Edit Cell” or “Press F2” to open the cell for editing; the insertion point is automatically placed at the end of the cell. As you dictate, the background changes to blue. Commands such as “New Line” operate within the cell.

**TIP:** To quickly enter a predictable series of values, such as days or months, you can use commands such as “Monday through Friday across” or “July through December down.”
Select-and-Say™ in Quick Edits

You will want to practice entering data into a spreadsheet and navigate around the spreadsheet and within cells, as well as dictate and correct text using Select-and-Say commands like “correct <xyz>”.

For the exercise below, the content of the spreadsheet is not important.

Step 1: Open Excel, say open document and locate the relevant .xls file - or use a blank file.
Step 2: Say move to cell C7 (or Charlie seven.)
Step 3: Dictate your full name into the cell.
As you dictate, the cell background turns pale yellow, indicating that Dragon is doing a Quick Edit.

Let’s practice Correction:

Step 1: Say move to cell C 13 (or Charlie 13). Dictate some text that is likely to contain unknown words, such as: “Travel to Ashtabula to provide support for Sporkatron, Inc.”
Step 2: Correct one of the recognition errors. (Leave the remaining errors as they are, so you can practice coming back to this cell and correcting them later.)
Step 3: Say move down one to go to cell C14. Dictate some additional text that is likely to contain new words, such as: “related to last week’s trip to Kenmawr—training Moosehart Insurance”

Now that you are out of the cell, practice going back to it and correcting the error(s) in it.

Step 1: Say move up one to move back to cell C13. Say a “correct <xyz>” command to correct another of the errors Dragon made. Notice that the cell again turns yellow.
Continue correcting the text until it is accurate.
Step 2: Say apply. You are no longer in Quick Edit mode; the cell you were editing is still selected.

Now let’s practice entering numeric data rapidly into a row.

Step 1: Say move to cell B16 or move to cell Bravo 16 to move to the Breakfast row. Dictate a numeric value such as six dollars and fifty cents.
Step 2: Say move right one to move to the next Breakfast entry. Fill in the rest of the row.
Key points about editing cells in Excel

✔ You can navigate between cells using absolute commands such as move to cell A1 or relative movement commands such as move up one, move right two, etc.

✔ If you want to mention a cell in a command (such as “move to cell D5”, or “select cell B3 through cell H3”), be sure to say the word “cell”. You can use alpha bravo Charlie etc. instead of A B C.

✔ If you wish to modify and add to the existing content of a cell, move to that cell, then say Edit Cell or Press F2; the insertion point will appear at the end of the cell’s content and the cell will now have a blue background. If you say commands like New Line and New Paragraph, these commands are executed within the cell.

✔ If you just move to a cell and start to dictate, what you dictate will overwrite the existing content.

✔ You can use Dragon commands like select <xyz>, correct <xyz>, and insert before <xyz> to edit and correct text in a cell.

✔ To complete entry and move down one cell, say press Enter. To cancel entry and remain in the cell, say cancel or press Escape.

✔ Saying apply completes entry into a cell, and leaves the focus on that cell (exiting Quick Edit mode).
Boosting Productivity with Custom Commands

In previous lessons, you learned various built-in voice commands to perform actions such as formatting text, searching the Internet, creating a new e-mail, creating a new appointment... The higher editions of Dragon also allow the creation of custom commands.

There are several types of custom commands; this workbook presents the “Text-and-Graphics” type, which allows you to define boilerplate for Dragon to paste wherever you utter the command. As the name indicates, this boilerplate can contain graphics, such as logos, scanned signatures, maps... Quick and easy to create, Text-and-Graphics commands provide considerable time-savings and convenience. In Version 10, you can even include fields in them—a very easy way to create templates that can be both created AND navigated by voice.

Creating Boilerplate Commands (“Text-and-Graphics” Type)

Step 1: Open the MyCommands Editor—you can say add new command or click Tools>Add New Command.

Step 2: Choose a name for your command and enter it in the MyCommand Name field.

IMPORTANT: The command's name is the phrase you will say to cause the command to execute. Choose it well! It should be easy to remember and easy to say, like Paste Signature Block and Enter Home Directions.

- Choose a descriptive, meaningful name (as opposed to a name like “macro 3”.)
- Make it neither long nor short (between 2 and 5 words is usually best). Avoid single words, and phrases you may need to dictate.
- Use words that are easily pronounced and recognized (all words in the command name should be in the Vocabulary), and avoid symbols—for instance, use “number” instead of “#”, otherwise Dragon would expect to hear “number sign” or “pound sign” when you say the command.

Step 3: In the Description field, enter some information about your command. This is optional, but it helps remember any important details about the command (its intent, when and where you might use it...).

Step 4: In the Group field, highlight the word User-Defined. Entering a new group name (your name, for instance, or the name of the application or task for which you are creating the custom command) will later allow you to locate and manage your custom-created commands quickly.

TIP Once you’ve defined a command Group, you can easily add more commands to that group (Dragon will now include your group’s name in “Group” list). Doing so ensures that your custom-created commands will be filed together, and will be easy to manage as a group.

If desired, you can always rename the group or assign the command to another group later.

Step 5: In the Content field, enter what you want Dragon to paste when you say your command. (You may find it helpful to enlarge or even maximize the Editor’s window so that a larger Content field is visible.)
**TIP** If the text you want already exists in electronic form, you can save time: highlight the desired segment in the original document, then say “make that a shortcut”. Dragon will automatically open the Editor and paste the selection in the Content field. All you have to do now is specify the command’s name and attributes, and edit the Content as needed.

As its name suggests, this type of custom command lets you include graphics as well as text: you can paste images from another application into the Content field—many people include maps, logos, or scanned signatures, for instance.

**Optional:** If desired, format the text entered in the Content field: you can use the buttons (bold / align / center...) below it. Clicking the Aa button opens the Font window, where you can choose the desired font style, size, color, etc.

**IMPORTANT:** In cases where you want the content to match the formatting of what preceded it in your document, check the Plain Text checkbox, at the bottom right of the MyCommands Editor.
Step 6: Once the command is named, edited, described, grouped, and formatted as you want it, click Save.

Let’s test your command. Say start DragonPad, then say your command’s name. (Commands you create yourself follow the usual rule: you must pause before and after, but not in the middle!)

You may realize now that you could make your command even more convenient: for instance, by adding a blank line before the content so your pasted content automatically starts as a new paragraph. A section below explains how to edit a custom command.

“Cloning” Commands and Adding Name Editor Variables

Instead of making a command from scratch, you can create a new command based on the “clone” of an existing one, by clicking New Copy on the Command Browser (or the Create New button on the Command Editor.)

In addition, the MyCommands Editor’s Name Editor allows the inclusion of <variables> in your command names. Variable names provide flexibility (so you can use synonyms instead of just one wording) and can make your custom commands even more useful, by letting them perform variations on the same action.

The variables can be synonyms, or they can be different values, such as numbers from 1 to 10.

<1to10> is one of the pre-filled lists available through the Name Editor, but you can also make your own (as was done for <hq_nuance> in this lesson’s illustrations).

See the Help for details.

“DragonTemplates”: Boilerplate Commands with [Fields]

(Higher editions only) Dragon 10 added to the Text-and-Graphics command type a new capability which gives you a very simple way to paste a “voice template” containing fillable fields.

To create a field in a command’s Content box, click the Variable button at the bottom of the MyCommands Editor. By default, each field appears between square brackets as “[default value]”. (If you prefer delimiters other than square brackets, you can indicate that in the Commands tab of the Options dialog.)

After saying the command name, which pastes the “DragonTemplate”, you can:
• **type or dictate** a specific value in each placeholder → The placeholder is overwritten, and delimiters are removed.

• **accept the default** value → Delimiters are NOT automatically removed; you can say "clear variable delimiters".

To navigate a DragonTemplate's Fields, you can select the desired Field with the mouse, or use the voice commands "Next Field" or "Previous Field." (These commands only work where all of Dragon's functionality is supported—where the DragonBar’s Select-and-Say Indicator is green).

**Managing Custom Commands**

After you create commands, you may wish to edit them. If your phone number changes, for instance, you will want to edit commands containing it. You may also want to rename, delete, or share commands.

A tool called the Command Browser lets you search for commands as well as manage your custom commands. Deleting, renaming, modifying, exporting and importing custom commands can be done through its Manage area, as follows:

**Step 1:** Say start Command Browser. (You can also use the link in the Accuracy Center or the Tools menu).

**Step 2:** On the Mode section of the Browser’s Task Pane, click Manage (or choose it from the Mode menu.)

**Step 3:** Open the Group drop-down list. If you created a separate group as suggested earlier, its name will appear here; choose it. Otherwise, the commands you made will be under User-defined.

**Step 4:** The Command Browser now displays only the commands in the specified group, listing them by availability. You can use the + symbol to expand the display.

**Step 5:** Check the box next to the desired command, then click To Script (which at that point will be accessible in the Manage menu.)

This takes you to the Command Browser’s Script display, which shows all the modifiable commands.
Step 6: With your command highlighted, click Edit (or use the Script menu). The MyCommands Editor will open, displaying the command’s attributes and content; you can now edit the command as desired.

Remember: the Description field is useful for entering comments such as where and when the command should be used, or reminders like “make variations of this ASAP” or “change this after we move”. Your notes may seem obvious at the time, but they really help later!

**IMPORTANT** You can delete commands visible through the Script or Manage displays: check the box next to the desired command(s) then choose Delete (from the menu).

---

**Finding commands via the Command Browser’s “Filter”**

One of the ways you can find commands in the Command Browser is by using the ability to filter the display to show only the commands whose name contains a particular word or words: choose Filter from the Command Browser’s toolbar (visible in the upper-right corner when in Browse Mode) to specify one or more words. The Filter button is useful for finding custom commands (particularly if they were not filed under a Group name), and also for finding built-in commands, since Dragon contains far too many to list even in the online Help.

**TIP** It’s a good idea to explore the Command Browser for commands related to items you might like to address by voice: you might filter for words like border, indent, double space, table, row, column…

The Command Browser’s display may seem strange at first, as instead of full words some lines may contain ellipses (...), parentheses, and <angle brackets>, in order to fit in the space and represent the many optional and alternate elements, like “the” and “a”. You can view the full wordings by using the Browse menu’s items—Refine and Undo All are particularly useful.

To practice, pick your usual word processor in the Context drop-down list, and use the Filter to find commands on items you often use in this application. (The illustration below shows the result of filtering for the words “rest” and “paragraph” in Microsoft Word 2003.)
Key points about custom commands

- You can quickly create custom commands to insert blocks of text and/or graphics in your documents. This is done in the tool MyCommands Editor, which you can bring up by saying add new command.

- If the boilerplate text already exists in an electronic document, you can copy and paste it into the MyCommands Editor’s Content box, or say make that a shortcut.

- Providing a Group name for your custom commands makes it quick and easy to locate and manage them later. It’s also a very good idea to use the Description field to note a comment, a reminder...

- Names for custom commands should be memorable, intuitive, easy-to-pronounce phrases. Avoid names that could be used as dictation, such as single words.

- The Name Editor lets you add <variables> in command names, to provide synonyms or variations (using lists you define yourself, or existing lists such as 1to10.)

- In the Professional and Legal editions, you can add fillable [Fields] to your boilerplate commands to create “DragonTemplates” which can be navigated and filled out by voice.

- The Command Browser allows you to rename, modify, “clone”, delete, export and import custom commands.
Performing Audio Checks and Acoustic Training

You already know that personalizing Dragon’s vocabulary is a small investment of time that makes a big difference in how accurately the software can work for you. You also know that using proper correction technique to fix misrecognitions allows Dragon to learn from its mistakes.

In certain cases—if you are adding a new word with an unusual pronunciation, if a certain word is consistently misrecognized, or if your overall accuracy is lower than you expect, you can also perform additional acoustic training to improve accuracy.

This lesson presents how to use the Train Words window and how to bring up a supplemental training text. You also learn to run the Audio Check, a short but important process!

Training Words from the Vocabulary Editor

You have learned to add new words to the vocabulary, as well as to create Spoken Forms for items pronounced differently from their spelling. Spoken Forms are often the most efficient way to ensure accurate recognition.

If you suspect that Dragon needs help recognizing a tricky word (particularly a foreign word whose sounds you cannot represent in a Spoken Form), you can acoustically “train” that word's pronunciation.

Step 1: In the Vocabulary Editor, locate the word you wish to train by entering it in the Written Form field. (If you have just added the word, this will not be necessary, as the word will already be displayed at the top of the list.)

Step 2: Click the word in the list so it is highlighted, then say or click Train. The Train Words window opens. Are you ready? (If you need to clear your throat, do it first!) Click Go, and read the prompt in your normal speaking voice, as if you were saying this word in the middle of a sentence.

Step 3: You may have to wait a second for this acoustic information to be incorporated. Be patient! Then, you can say or click Done to close the Train Words window.

IMPORTANT: When giving Dragon acoustic training, be sure to use your natural dictation voice: relax, and speak clearly but not louder or slower than you would when dictating normally. If you over-enunciate in the Train Words window, you give the software acoustic data that isn’t representative of how you usually dictate. Remember, when you are training software to recognize your speech, you must represent your speech accurately!

Training While Correcting

If Dragon misrecognizes what you said, correcting the mistake contributes to the overall accuracy and makes it unlikely that this mistake will happen again. As you know, adding a Spoken Form is often a quick solution.

To help the recognition of a word, you can provide acoustic training right as you correct it in the Spell dialog box, since it contains a button labeled Train.
Step 1: Begin as you normally would, by saying correct immediately followed by the incorrect word(s) Dragon placed on your screen. The Spell dialog box will appear as usual.

Step 2: Because you wish to train the pronunciation of this word, proceed slightly differently than usual:

If the correct choice appears in the list, single-click it, or say select 2 (or whatever number corresponds to the choice) rather than choose 2 as you normally would. This will highlight the correct choice but will not close the Spell dialog.

If the correct choice does not appear in the list, spell out or type the desired word(s), but do not click OK or press Enter as you normally would.

Step 3: Click the Train button or say Train.

Step 4: The Train Words window opens. Say or click Go. You will be prompted first to pronounce the correct word(s) and then to pronounce the incorrect word(s) Dragon placed on your screen.

After reading the second line, click or say Done to close the window.

IMPORTANT: Remember that, when providing acoustic training (and especially doing so after a misrecognition), there is a natural tendency to over-enunciate or speak loudly. Be sure to avoid this. Since you won’t over-enunciate in your normal dictations, doing so in the Train Words window would provide Dragon with non-representative acoustic data. Instead, speak the word or phrase as you normally dictate.

Checking Acoustic Settings

Use Dragon’s audio check if something in your environment has changed: new computer, new microphone, new room, different ambient noise... Also, if your overall accuracy is lower than expected, perform this check to verify that your audio hardware is functioning correctly.
Step 1: From the Accuracy Center, click or say Check your Acoustic Settings. The Audio Setup Wizard opens. (You can also access the Audio Setup Wizard directly by saying check audio or check audio settings.) Note that opening the Audio Setup Wizard automatically turns off the microphone.

Step 2: Follow the Wizard’s screens as when you first created your User profile: click the Start button and read the content of the gray box. Dragon will indicate whether the check passed.

- If it failed, verify that your microphone is plugged in correctly and that its listening side is facing your mouth. If these are correct, there is probably a problem with your audio hardware; click the Help button (and see knowledgebase.nuance.com if needed.)
- If it passed, click Finish. (If accuracy is still lower than expected, use the Accuracy Assistant.)

Performing Additional Training

Everyone should consider providing some reading for acoustic training after the first few days of practicing dictation: by then, speaking clearly into the microphone will be familiar, and acoustic training should reflect how one actually dictates.

If your speech presents a challenge for Dragon, due to an Italian or French accent for instance, you should perform additional training as soon as possible.

Step 1: Say start Accuracy Center, then click or say Perform Additional Training.

Step 2: When the Select Text window opens, choose a text to read, then click OK. The General Training window will open. Click Go to begin reading.

IMPORTANT: Remember, try to speak clearly but naturally and read exactly what is on the screen. If the software needs to hear you read something again, a yellow arrow will show you where to resume reading. If necessary, click Pause, then click Go when you are ready to resume.

Key points about acoustic training

- In general, the best thing you can do to make Dragon recognize your speech even better is to use the software regularly, personalizing the Vocabulary and correcting misrecognitions.
- In certain cases, however (if a certain word is consistently misrecognized, or if overall accuracy is lower than you expected) you will want to provide some additional acoustic data.
- You can train Vocabulary entries from the Vocabulary Editor (either one at time or several at once).
- When providing acoustic training, remember to speak as in your regular dictation. This is particularly important when you train a corrected segment and the original misrecognition (avoid over-enunciating the difference between the two alternatives.)
- At any time, if you feel that the accuracy is not as high as usual, you can access Dragon’s Audio Check to verify that there is not a problem with your audio hardware—through the Accuracy Center, or by saying a command like Check Audio.
- If your audio quality check passes but accuracy is not as high as expected, take a moment to perform some reading for acoustic training—you can do this via the Accuracy Center.
Creating and Using Multiple Vocabularies

Every Dragon NaturallySpeaking user automatically has at least one Vocabulary. The Professional, Legal, and Medical editions of Dragon allow you to have several Vocabularies, although it is relatively rare for a person to need more than two or three. The advantage of having several Dragon vocabularies is being able to customize each one to perform best for very different topics or different styles of dictation.

For instance, suppose an architect uses Dragon to dictate business letters and site reports, but also frequently uses it to write a newsletter for his community theater group. In his work-related dictation, he might use formal business language and mention technical terms and brands of construction materials. He might want to add the abbreviations for building codes, as well as the names of clients, contractors and other contacts he mentions in his work. When writing for his theater group, however, his dictation style might become significantly more casual and the words he uses most frequently would be different.

Having multiple Vocabularies helps achieve optimal accuracy in different dictation types. The documentation contains many details about creating and managing vocabularies. This lesson presents the essentials.

Creating a New Vocabulary

Creating a new vocabulary is very similar to customizing your original vocabulary. It starts in the Manage Vocabularies dialog box.

Step 1: Say Manage Vocabularies or, on the DragonBar, click NaturallySpeaking > Manage Vocabularies, then New...

Step 2: The New Vocabulary window opens. Choose a descriptive name and enter it in the Name field. From the drop-down list, choose the vocabulary on which you want your new vocabulary based (what you see in the list varies if you have the Legal or Medical edition of Dragon):

- If you want to create a vocabulary which already contains the custom words from your existing vocabulary, choose this existing vocabulary from the list: e.g. General - Large.
- If you want to create a vocabulary which does NOT contain any of the custom words from your existing vocabulary, choose the Base vocabulary.

Step 3: Dragon will then offer to run the Vocabulary Optimizer. This automatic tool may take a while, and is not as powerful as the other vocabulary tools. Instead, you can choose Cancel, which exits the Vocabulary Optimizer. Then you can customize your new vocabulary using what you learned in previous lessons: Import a list of Words, Increase Accuracy From Email, Add Words From Documents... (see the Accuracy Center.)

Managing Multiple Vocabularies

After creating (or importing) a new Vocabulary, you may wish to rename or delete it; both are done in the Manage Vocabularies dialog box.
From there, you can also Export a Vocabulary (to burn it to a CD or save it to a USB drive, for instance). This would allow you to share it with other users; the recipient user would also access the Manage Vocabularies dialog, choose Import and browse for the exported Vocabulary’s .top file. (See the Help for more details.)

NOTE: If you have multiple Vocabularies for the same User profile, this will be reflected in the Open User window, which will appear when you start Dragon.

The Open User window also shows the different dictation source(s) that may be available for the User profile(s) present on your computer. You can pick the line containing the Vocabulary (and, if application, User and Source) you wish to open.

During your dictation session, you will be able to switch to a different Vocabulary, by saying open recent vocabulary, for instance.

Key points about multiple Vocabularies

- If you dictate on two or more very different topics, using different customized Vocabularies will maximize your recognition accuracy. Each Vocabulary can be customized using the tools in the Accuracy Center—adapting to documents you designate, for instance.

- If you have several Vocabularies, you will be prompted to choose one when you start Dragon. You can switch to a different Vocabulary later, by saying open recent Vocabulary, for instance.

- The Manage Vocabularies dialog lets you create, delete, open, rename, import and export Vocabularies; it opens with the command manage Vocabularies (or from the NaturallySpeaking menu).

- With the Medical or Legal edition, one can create or import medical or legal Vocabularies.
Acoustic and Language Model Optimization

Proper correction and Vocabulary customization both help Dragon recognize your speech more accurately. Acoustic and Language Modeling Optimization is a functionality you can use to further “tune” the accuracy for your specific usage:

- It refines your User profile using the latest acoustic data archived from any corrections and acoustic training you performed.
- It uses text extracted from your previous dictations to add frequent word sequences to the Language Model (Dragon’s statistical information that predicts which words are most likely to occur when you dictate).

This “Accuracy Tuning” can take a while, depending on your computer’s resources and on the amount of data accumulated. (Before running it, Dragon automatically backs up your User profile.)

It becomes available once you have performed enough dictation, correction and training. Depending on how many hours of dictation you typically do, you might run it after a few weeks of using Dragon and then about once a month.

The accuracy boost will depend on factors such as the amount and quality of the initial training and optimization (if performed during profile creation, the initial accuracy experienced, and the amount and quality of text and audio data available for processing.)

Note: If you have recently dictated in a very different sound environment, such as an airplane, you should not let Dragon perform acoustic optimization.

Launching the Acoustic and/or Language Model Optimization

Step 1: In the Accuracy Center, use the link “Run the Acoustic and Language Model Optimizer.”
Step 2: Check the Acoustic or Language Model checkbox as desired, then click Go. (As the dialog box mentions, you should run this tool when your PC is not being used actively.)

Dragon will let you know once it has collected enough data for its automatic optimization.

Scheduling the Optimizations—and Data Collection

For convenience, Dragon lets you schedule a specific time and frequency for these optimizations.

The User Guide contains details about access to these optimizations and Dragon’s scheduling by both end-users and Administrators; the latest version is downloadable along with other Dragon documents at support.nuance.com/usersguides.

**IMPORTANT:** In addition to “Accuracy Tuning”, another task that can be scheduled is the sending of anonymous recognition data over the Internet. This Data Collection will help Nuance’s Research & Development team improve future releases of Dragon both for you and for all other users.

When you schedule either Accuracy Tuning or Data Collection:

- You may be prompted for your Windows username and password, since Dragon uses the Windows Task Scheduler for this automation. Dragon does not use or store your password in any way.
- Pick a time when your computer will be on, but you’re unlikely to be actively using Dragon.

**If Your Windows Password Changes**

Your company may require that employees change their Windows password regularly.

If Accuracy Tuning or Data Collection had been scheduled and your Windows password changes, when the time for the Dragon task comes, Dragon will present a message stating about missing required credentials. You can
address this through the **Scheduled Tasks** tab of the **Administrative Settings** dialog (accessible from the DragonBar’s Tools menu after choosing Close User from the NaturallySpeaking menu). Windows will ask you to enter your new password.

The Data tab of the Options dialog

---

**Key points about Acoustic and Language Model Optimization**

- The Acoustic and Language Model Optimizer can automatically “tune” Dragon by making it review all the acoustic data and/or text data it has gathered from your usage.

- This Optimization can be launched at any time from the Accuracy Center. It can also be scheduled so that Dragon performs it at a specific frequency and time (the scheduling uses the Windows scheduler, so it requires a Windows password.)

- When scheduling Accuracy Tuning (and Data Collection), pick a time when your computer will be on, but you’re not likely to be using Dragon.
Copying User Profiles

As you learned, each person who uses Dragon NaturallySpeaking creates a User profile, which the software holds in a set of user files containing, among other things, acoustic and lexical data. When you add a personalization to the Vocabulary, correct a misrecognition, read a training text, or change a setting in the Options dialog, Dragon can save these refinements in the open User profile. Although Dragon automatically creates User profile back-ups (by default, every five times the profile is saved), it is a good idea to keep your own record of customizations—by exporting your custom words and custom commands for instance, or noting what optional settings or what Word Properties you have changed...

You can also copy your whole User profile—for safe-keeping, or to make it available on another computer. Copying User profiles is a simple two-part process. You must first Export from the original computer then Import from the recipient computer. This is accomplished through the Manage Users dialog box.

Step 1: Say manage users or click NaturallySpeaking, Manage Users. The Manage Users window opens. Select the User you wish to copy, then choose Advanced > Export.

Step 2: A Browse window opens. Choose the location to which you want your User exported, then click OK.

If both computers are on a network with a shared drive, this network drive is probably the easiest location. Otherwise, you can export your profile to a media storage device, such as a portable USB drive. (User profiles are too large to fit on a floppy disk.)

Now that your User profile is exported, it can be imported:

Step 1: From the second PC, open the Manage Users dialog box. Choose Advanced> Import.

Step 2: When the Browse For Folder window opens, locate the folder containing the exported User (this folder bears your User profile’s name). Once it is highlighted, click OK.

Key points about exporting and copying User profiles

- You must Export the User profile from the original computer, then Import it to the recipient computer.
- Exporting and importing Users is done through the Manage Users dialog box—available through the NaturallySpeaking menu or by saying manage users.

The documentation contains more information about managing User profiles: deleting, renaming, backing up, restoring... See for instance topics on Dragon's Roaming User feature (available in Professional and higher editions), which presents administrative advantages and is particularly useful for people who frequently dictate from different PCs connected to the same network.
Practice Exercise: Creating a Memo by Voice

Bring up DragonPad or your usual word processor. Using your new dictation and formatting skills, try to create the following document entirely by voice—feel free to replace the signature block with your own.

Take this opportunity to practice looking up keywords in the online Help or the PDF file of your User’s Guide to find out more ways to accomplish a particular task by voice.

AnyCorporation
Gene Hansen-Wolffe
P.O. Box 3299
Minneapolis, MN 67811-3299

August 5, 2008

Dear Gene,

I am pleased to report that my team has reviewed the Western Region Report for this quarter. As of July 29, 2008:

the total is $875,500.

Please let me know your projected figures for the rest of Q3.

As always, don’t hesitate to contact me at the number below.

Sincerely,

Sara Petersen
Regional Sales Manager
My Company, Inc.
202-965-5000
mobile: 715-377-1925
fax: 800-968-2231
sara.petersen@mycompany.com
Visit www.nuance.com/naturallyspeaking for tips, FAQs, compatible microphones, digital recorders, and more